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Preface

The guava easyCyte™ System is an automated, desktop cell analysis system that can 
perform a wide range of multi-color cellular and assays. The system is equipped with 
three lasers—violet, blue, and red—allowing you to analyze up to 10 fluorescence 
parameters, as well as forward and side scatter. It accommodates individual 
microcentrifuge sample tubes.
guavaSoft™ software, used to set up and maintain the system, offers a number of assay-
specific acquisition and analysis modules, depending on your applications. Use the guava 
InCyte™ software module to acquire and analyze data. InCyte™ is an open software 
package, which you can also use to analyze FCS 3.0 data files acquired from any guava® 
software module. For a list of assay-specific software modules, see “Program Search List” 
on page 1- 9.
guava InCyte™ application templates are available for all FlowCellect® assays. The 
templates provide the plots, parameters, analysis tools (Methods), and statistics for each 
application. For more information on these templates, refer to the specific reagent kit user 
guide. 
vii



About This Guide
The guava easyCyte™ System User Guide provides detailed information on operating 
and maintaining the guava easyCyte™ System, and using the guava InCyte™ software 
module for data acquisition and analysis. This guide is intended for the guava easyCyte™ 
5, 6-2L, 8, and 12 instruments. Any reference to NIR, Red2, and NIR2 parameters, may 
not apply to your specific instrument. Refer to “easyCyte Lasers and Fluorescent Filters” 
in Specification for a complete list of the parameters available with each system. For 
information on using the other guava® software modules, refer to the guavaSoft™ 
Modules User Guide.
This guide assumes you have a working knowledge of Microsoft® Windows® operating 
system. If you have any questions regarding the Dell™ computer or the operating system, 
refer to the appropriate manufacturer’s documentation.
For information on preparing samples, refer to the appropriate reagent kit user guide that 
was shipped with your reagents.

Conventions Used in This Guide
■ NOTE: Points out additional information that may be helpful.

◆ WARNING: Alerts you to situations that could result in bodily harm, instrument 
damage, failure in a procedure, or incorrect results.

Bold: Indicates buttons to click or options within the software to select.

Italics: Used for names of user guides and package inserts, as well as messages that 
appear on the screen.

Help

1 Read through the section of the guide specific to the operation you are performing. 
Refer to the table of contents and index to locate information. A glossary is included to 
assist you with any unfamiliar terms.

2 See the Troubleshooting section in each chapter for a list of problems and suggested 
solutions. 

3 Refer to the technical support contact information listed below:
• For ordering information or technical support, call toll-free:

USA and Canada, Phone: +1 (800) 645-5476 Fax: +1 (951) 676-9209
• For additional contact information, visit www.millipore.com/flowcytometry

Safety
The guava easyCyte™ System is equipped with safety features for your protection. Use 
the system only as directed in this user guide. Do not perform instrument maintenance or 
service except as specifically stated. Please read the following safety information before 
using the system.
viii guava easyCyte™ System User Guide



General Safety

◆ WARNING: If this instrument is not used in the manner indicated by the instructions in 
this guide, the safety features of the instrument may be impaired. Follow these 
guidelines:
• The use of tubes other than those specified may result in damage to the 

instrument.
• Do not run any other programs, including Internet Explorer®, on the laptop while 

using guavaSoft™ Software to acquire data. guavaSoft™ Software requires the full 
resources of your laptop during data acquisition. Running other programs during a 
run may interfere with acquisition or interrupt the run.

Biological Safety

◆ WARNING: All biological specimens and materials that come into contact with them 
can transmit potentially fatal disease. To prevent exposure to biohazardous agents, 
follow these guidelines:
• Handle all biological specimens and materials as if capable of transmitting 

infection. Dispose of waste using proper precautions and in accordance with local 
regulations. Never pipette by mouth. Wear suitable protective clothing, eyewear, 
and gloves.

• Add 10 mL of bleach to the waste vial after emptying it. Dispose of waste in 
accordance with federal, state, and local regulations.

Electrical Safety
The instrument must be connected per the instructions in the user guide. The power 
conditioner is required to meet electrical compliance.

◆ WARNING: Turn off the main power switch at the back of the instrument and 
disconnect the power cord before replacing fuses.

Laser Safety
The following lasers are used in the easyCyte™ System: 

■ NOTE: These are the maximum powers for each laser. For the actual power for a 
specified instrument model, see “easyCyte Lasers and Fluorescent Filters” under 
Specifications.

Laser Wavelength (nm) Maximum Power (mW)

Violet 405 ±5 110

Blue 488 ±5 160

Red 642 ±5 110
ix



No radiation is accessible to the user during normal operation and maintenance. Light 
shields within the instrument enclose the path of laser radiation. Additionally, the 
instrument enclosure provides secondary protection from any laser radiation. 

◆ WARNING: To avoid exposure to laser radiation or electric shock, follow these 
guidelines:
• Do not open the instrument or attempt to perform any internal maintenance. There 

are no user-serviceable parts.
• Turn off the power to the guava easyCyte™ System before attempting to remove 

the flow cell.

◆ WARNING: The use of controls or adjustments or performance of procedures other 
than those specified herein may result in hazardous radiation exposure

Labels

Following are examples of the labels affixed to the guava easyCyte™ instrument:

Limitations
• The guava easyCyte™ System is for research use only; not for use in diagnostic 

procedures.
• The results of the assays are dependent upon the proper use of the reagents and 

instrument. Refer to the appropriate reagent kit user guide for specific instructions and 
limitations.

USA and Japan Europe 

110 VAC 220 VAC 

FUSE 2A Time-Lag 1.6A Time-Lag

CAUTION - CLASS 3B
LASER RADIATION 
WHEN OPEN. AVOID

EXPOSURE TO BEAM

Passed

By:

Date:

D.C.

7/08/05
B

S/N : 8470120101

Manufactured:  04JUN2014

NOTE: The following caution label is visible when 
the flow cell access panel is removed. The panel 
is to be removed when the system is powered 
off. Even when powered on, the accessible laser 
radiation falls within Class I limits.
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CHAPTER 1
Introduction

guava easyCyte™ System
The guava easyCyte™ System streamlines cell phenotyping, drug discovery, and cell 
culture monitoring and screening by providing turnkey assays for a wide range of cell-
based applications. The system includes the easyCyte™ instrument, a laptop computer 
with pre-installed software for data acquisition and analysis, and optimized reagents and 
protocols. 
guavaSoft™ software includes dedicated application modules for cell- and bead-based 
assays, minimizing training requirements. In addition, the software includes the guava 
easyCheck™ module, which verifies that the system is performing optimally, and Guava 
Clean, a cleaning module that allows you to clean the instrument’s fluid system prior to 
shutdown. 

guavaSoft™ software automatically saves data files, which can be recalled later for offline 
analysis. In addition, results are exported to a spreadsheet file. 

guava easyCyte™ System
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System Components
The easyCyte™ System is shipped with the following components.

Hardware Connections
Although the easyCyte™ System is a portable unit, it contains precisely aligned optical 
components that are sensitive to jarring movements. Place the instrument on a stable 
surface in a dedicated location in the laboratory. Allow at least 4 inches between the back 
of the instrument and the wall for proper ventilation. Maintain easy access to the power 
cord in case the instrument needs to be disconnected in an emergency. The initial 
installation will be performed by an EMD Millipore field service representative.

◆ WARNING: To avoid damage to the instrument, be sure to remove the shipping 
restraint before plugging in the instrument.

■ NOTE: If the instrument needs to be moved to a new location in the lab area or 
building, always use two people to lift and a sturdy transport such as a cart. If a longer 
distance move requiring packup is required, contact EMD Millipore. A Relocation and 
Installation service is available for a fee. See Appendix C: "Ordering Information" for 
details.

1 Connect the cytometer to the laptop with the USB cable (see Figure on page 1-3). 

2 Connect the power cable between the power conditioner and a grounded (three-
prong) AC power outlet. 

guava easyCyte™ System

power cable

guavaSoft™ software CD

sample tube 
holders

power 
conditioner

extension cable

laptop 
computer

laptop power supply 
and power cord

USB cable
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3 Connect the extension cable between one of the four power outlets on the back of the 
power conditioner and the power input on the cytometer.

■ NOTE: The power conditioner is required to meet electrical compliance.

4 Connect the laptop power supply to the laptop. Plug the power supply into the power 
cord, then plug the power cord into the power conditioner. 

◆ WARNING: The power conditioner is not a continuous power supply. Ensure that the 
instrument is powered on during acquisition. 

Connecting the guava easyCyte™ System

5 You can connect the laptop to a local network or the internet. Contact your network 
administrator for assistance. You can also connect a printer. If you connect a printer, 
you must install the appropriate print drivers.

6 The easyCyte™ System comes with two sets of sample tube holders: a set of holders 
for 1.5-mL microcentrifuge tubes and a set of holders for titer tubes. Select the set you 
want to use and install them by screwing each holder onto the loader assembly as 
illustrated below. 

The easyCyte™ System supports the following tubes:
• 1.2-mL microtiter tube with conical tip
• 1.5-mL microcentrifuge tube with conical tip and screw cap (if snap-cap tubes are 

used, cut off the cap)

Installing and changing the tube holders
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◆ WARNING: The use of tubes other than those specified may result in damage to the 
instrument.

7 Refer to “System Startup and Shutdown” on page 2-1 for the correct procedure to 
start the laptop computer, easyCyte™ instrument, and guavaSoft™ software.

8 Prime the fluid system. Follow the instructions in “Running Guava® Clean” on page 3-2 
using deionized water in place of cleaning solution. Keep the tube of water loaded on 
the system whether you are ready to run samples or are going to shut down the system. 

easyCyte™ System Troubleshooting

Problem Possible Causes Solutions

Laptop prompts for user ID 
or password.

Laptop is set up for 
authorization.

Do not enter password. Click OK 
or Cancel to continue. Contact 
your IT department for assistance 
with any modifications. The 
original laptop setup does not 
require a password.

During start-up, laptop 
freezes on particular 
screen.

System may be searching 
for directory during 
startup.

Press Enter to continue. Reboot 
system, if necessary.

Message:
The instrument could not 
be detected.

Communication problem. Press Enter to continue. Reboot 
system, if necessary. If message 
appears after rebooting, contact 
EMD Millipore Technical Support.

Message: 
The instrument appears to 
be either off or not 
connected. You can run in 
Analysis mode only.

1. guava easyCyte™ 
System is not turned on 
or is not getting power.

2. Cable connection 
between easyCyte™ 
System and laptop is 
loose.

3. easyCyte™ System and 
laptop were not 
powered on in correct 
sequence or have lost 
communication.

1. Ensure easyCyte™ System 
power cord is properly plugged 
in and system is turned on.

2. Ensure USB cable is securely 
connected to laptop. Use USB 
2.0 ports if possible. Reboot 
computer, if necessary.

3. Turn off easyCyte™ System, 
exit guavaSoft™ software, 
restart laptop, turn on 
easyCyte™ System, wait for 
indicator light before starting the 
software.

guavaSoft™ software 
launches, but only 
Analysis mode is available 
when an assay is 
launched.

Registration code not 
entered or not entered 
correctly.

Enter registration code and 
ensure all characters are correct.
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◆ WARNING: Do not run Excel® software, Internet Explorer® browser, or any other 
program on the laptop while using guavaSoft™ software to acquire data from the 
guava easyCyte™ System. guavaSoft™ software requires the full resources of your 
laptop during data acquisition. Running other programs (even if you are not actively 
using them) during a run may interfere with acquisition or interrupt the run.

Instrument will not power 
on.

Loose power cable. Ensure instrument is plugged. 
Check all power connections.

Laptop keeps shutting 
down.

1. Power supply to laptop 
is faulty. 

2. Screen saver is 
interfering.

3. Laptop overheating.

1. Ensure laptop is plugged in 
correctly. Use surge protector 
and ensure it is plugged in and 
turned on.

2. Adjust power scheme screen 
saver options. Click Start> 
Settings>Control Panel. 
Double-click Display, select 
Screen Saver tab, click Settings 
under Energy saving features of 
monitor. Make sure “Setting for 
Always On power scheme” are 
all set to Never.
Laptop should not be allowed to 
“sleep.” guavaSoft™ software 
will stop acquiring data until the 
laptop is woken up.

3. Ensure cooling vents are clean 
and unobstructed.

For InCyte™ only
Message:
Sorry - this unlock is 
invalid.

Incorrect or no unlock key. Ensure the correct unlock key is 
entered. If necessary, contact 
EMD Millipore Technical Support 
to obtain unlock key.

Problem Possible Causes Solutions
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easyCyte™ Instrument
The easyCyte™ System was designed for easy operation and minimal maintenance. The 
power switch, sample loader, and waste and cleaning solution vials are the only instrument 
components that you will routinely handle, and most of your interaction is through the 
software via the laptop. The power switch is located on the back-right side of the 
instrument. 

Sample Loader 

The sample loader holds up to two sample tubes. The loader arm can be lowered and 
swiveled, allowing you to quickly switch from one sample to the next during acquisition.
To load samples, pinch the release lever with your thumb and forefinger and gently lower 
the arm assembly (figure 1). Once lowered, rotate the assembly to change the sample 
tube (figure 2), then push up on the assembly until you hear a click. 

sample loader

power switch
(located on back of 
instrument)

access to flow cell

guava easyCyte™ System and components

cleaning solution vialwaste vial

indicator lights

1. Pinch release lever and gently lower sample holder. 2. Rotate loader assembly to change tubes.

release lever
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Cleaning Solution and Waste Vials

The cleaning solution vial (located on the right ) can be filled with Guava® Instrument 
Cleaning Fluid (ICF), for easy system cleaning. For information on filling the vial, refer to 
“Filling the Cleaning Solution Vial” on page 3-4. 
The waste vial (located on the left ) captures the sample fluid after it exits the fluid 
system. Empty the waste vial at the end of each day or more often, if necessary. Add 
5 mL of bleach to the vial after you empty it (see page 3-5 for information). 

Fluid System

Sample uptake occurs through a capillary and is 
regulated by a variable-speed fluid pump. The pump does 
not require sheath fluid or other supplementary fluids for 
operation. 
Because the system’s sampling precision depends on the 
integrity of the fluid pathway, it is important to maintain a 
clean system. Do not allow samples to remain in the 
capillary for extended periods of time. Perform frequent 
cleaning cycles to prevent the build-up of cellular debris 
that may restrict sample flow. Always keep a tube on 
water loaded when the instrument is not in use. If a clog 
does occur, you can clear it by using the backflush 
feature, which reverses the flow of fluid and flushes it out 
of the flow cell at a high speed. Refer to “Backflushing the 
Fluid System” on page 3-4 for detailed instructions on 
using the backflush feature. 
Some assays allow you to select the sample flow rate for acquisition. For most assays, 
the Medium flow rate is the default. This works well when the sample concentration is 
approximately 500 particles/µL. If the sample concentration is higher, dilute the sample or 
use a lower flow rate. For assays where the peak CV is critical, such as Cell Cycle, use 
the Low or Very Low flow rate. Always use the same flow rate for acquisition that you use 
for adjusting the settings.

Laser

The guava easyCyte™ has three lasers—blue, violet, and red. During acquisition using 
InCyte™ or easyCheck™, all three lasers turn on. During acquisition using ExpressPro, 
the blue and red lasers turn on. During acquisition using any of the other guava® software 
modules, only the blue laser turns on. The lasers turn off when acquisition is complete.
■ NOTE: For information on the easyCyte™ lasers and the fluorochromes compatible 

with each, refer to "easyCyte Lasers and Fluorescent Filters" in Specifications.

Software CD

A CD contains guavaSoft™ software. The guava easyCyte™ System User Guide is 
installed with the software. 

capillary
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guavaSoft™ Software Overview
Use guavaSoft™ software for the acquisition and analysis of data.

Main Menu
The guavaSoft™ software main menu allows you to select an assay from either a list of 
favorites or the program search list. Essential Tools allows you to run easyCheck™, clean 
the instrument, or select Setup, where you can customize your list of favorites. Use 
links @ Millipore to quickly access EMD Millipore websites for information. 

Favorites

Favorites allows you to quickly select an assay. You can 
have up to seven assays at a time in your Favorites list. To 
add a favorite assay, select the assay from the Program 
Search list and click Add to Favorites. The new assay will 
be added to the bottom of the list. And if the list already 
consists of seven assays, the first assay in the list will be 
removed. 
To remove a favorite assay, click Setup under Essential Tools. Remove the check from 
the check box for the assay you wish to remove. Click DONE. 

guavaSoft™ software main menu
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Program Search List

The Program Search List allows you to select an assay to run or open a FlowCellect® 
template in InCyte™. You can create a Favorites list to quickly select an assay later. The 
main menu allows you to select from the following assays: 
• guava ViaCount® Assay for performing cell counting and viability assays
• guava® ExpressPro Assay for performing assays with up to six colors, or where time, 

area, and/or width parameters are necessary
• guava InCyte™ for performing assays with up to ten colors and two scatter 

parameters, or where time, area, and/or width parameters are necessary, or if you 
want to analyze any guava FCS 3.0 data files

• guava Nexin®, guava® Caspase, guava® TUNEL, and guava® MitoPotential Assays 
for performing apoptosis assays

• guava® Cell Cycle Assay for performing DNA cell cycle assays
• guava® CellPaint Assay for tracking target cells in mixed populations, or for 

monoclonal antibody (mAb) screening in mixed cultures
• guava® CellToxicity Assay for cell-mediated cytotoxicity determinations
• guava® CellGrowth Assay for cell proliferation studies and to assess the number of 

live versus dead cell

Additionally, FlowCellect® template are available for acquisition and/or analysis using 
InCyte™. See “FlowCellect® Templates” on page 1-11.

Essential Tools

guava easyCheck™ allows you to check the system’s counting, fluorescence, and 
scatter performance prior to running samples. The guava easyCheck™ Bead is a 
standard particle used with this tool.
Cleaning allows you to run Guava Clean, an automated system cleaning cycle that 
cleans the fluid system.
Setup allows administrators to:
• configure certain software features for specific users (see “Appendix A: Administrator 

Features” for more information)
• remove assays from your Favorites list
• enter assay registrations codes (see “Unlocking guava InCyte™” on page 1-10)

■ NOTE: The Setup button is available only when an administrator is logged onto the 
system.

links @ Millipore

This section allows you to access commonly used EMD Millipore websites. You must 
have internet access.
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Check for Template Updates

Select Check for Template updates to search online or, if you are not connected to the 
internet, any available USB drives, for the latest FlowCellect® templates. The system will 
notify you if you currently have the latest templates installed. 

1 If updated templates are available, the following dialog appears. Click Yes to install 
the latest template package. 
Click Export to download the templates to a USB drive. 

2 Click Close when you receive confirmation that the latest templates were installed. 
If you chose to export the templates to a USB drive, select the drive from the drop-
down menu and select Export.

Exit 

Closes guavaSoft™ software

Unlocking guava InCyte™
guava InCyte™ requires an unlock key. If you get a message containing your computer 
code and prompting for an unlock key, e-mail EMD Millipore Technical Support and they 
will provide you with an unlock key for InCyte™.
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FlowCellect® Templates

Software templates are available for all FlowCellect® assays. The templates can be used 
for acquisition and/or analysis. Open a template before acquiring your samples in 
InCyte™. The instrument settings, plots, gates, and markers for the assay are contained 
in the template. If you already acquired data using either InCyte™ or another guavaSoft™ 
module, open the data file in the template and perform analysis using the Analysis 
Method provided.
Templates for the following assays are available:

• FlowCellect® Cytochrome c for mitochondrial cytochrome c loss
• FlowCellect® Human CD4/CD8 T Cell for quantification on CD4 and CD8 T cells
• FlowCellect® Human T Cell Caspase for caspase activation in CD4 and CD8 T cells
• FlowCellect® MitoCaspase for caspase and mitochondrial membrane depolarization 

detection
• FlowCellect® MitoDamage for apoptosis, mitochondrial membrane depolarization, 

and cellular death detection
• FlowCellect® MitoPotential Red for mitochondrial membrane depolarization and 

cellular death detection 
• FlowCellect® Th1/Th17 for Th1 and Th17 intracellular cytokine detection

Using a FlowCellect® Template

For more information on using the templates, refer to the user guide for the individual 
assay kit. 

1 To open a template, select it from the Program Search list and click Launch.
The assay template opens in InCyte™.

2 Select the Analyse or Acquire button at the top of the control panel. Perform 
acquisition or analysis according to the instructions outlined in the kit user guide.
• If you are acquiring samples, the instrument settings should be close to what you 

need. Check the settings and fine tune, if necessary.
• If you are analyzing InCyte-acquired data, but you acquired the data without the 

use of a template, you will need to drag the template Analysis Method to the 
Analysed Group. Check the gates and markers and fine tune, if necessary.

• If you are analyzing a data file acquired using a program other than InCyte™, open 
the data file. The assay template will contain the appropriate Analysis Method. You 
will need to create an Analysed Group and drag the data file and the Analysis 
guavaSoft™ Software Overview 1 - 11



Method to the Analysed Group. Check the gates and markers and fine tune, if 
necessary. 

guava InCyte™ Overview

About guava InCyte™
guava InCyte™ was developed to be an open assay module providing all the tools for 
instrument setup, sample acquisition, and data analysis. 
The guava InCyte™ module allows you to acquire and analyze up to ten fluorescence 
parameters in combination with forward scatter (FSC) and side scatter (SSC), as well as 
area, width, and time. It provides automated compensation and an instant update feature, 
making it easier to perform complex analysis.

Key Features

A single Method (or analysis strategy) can be applied to multiple data sets in parallel, or 
multiple Methods can be applied to a single data set to obtain statistics to be displayed in 
the heat map. The process of creating equation-based gating schemes has been 
simplified through use of drag-and-drop regions; “draggable” features are used 
throughout InCyte™.
The HeatMap allows you to visually compare results using a plate map that displays 
varying shades of blue to represent relative statistical values. Results from up to six 
parameters or six data sets can be displayed simultaneously.
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Additionally, all channels can be used with reagents that fluoresce in appropriate 
channels. Refer to "easyCyte Lasers and Fluorescent Filters" in the Specifications section 
for filter information.

Components of InCyte™ Files

Data files acquired using InCyte™ contain raw FCS data, the analysis components also 
known as Methods (regions, gates, markers, statistics, etc), instrument settings, and 
compensation settings. The raw data combined with the Analysis Method make up the 
InCyte™ Analysed Group.
At the start of acquisition, you have the option to select a Method, instrument settings, 
and compensation settings. These components can be retrieve from a saved InCyte™ 
FCS file. You can also retrieve the Method and/or instrument settings from individual 
saved Method and instrument settings files. If you do not retrieve a Method, a default 
Method will be applied. 

Tool Bar
The tool bar appearing on the far left side of the window provides additional features for 
acquisition and analysis. The features are also accessible from the Tools menu. Other 
than the Pie Legend, which is described on page 4-5, the tools are described in detail at 
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the point in the workflow where they are used. 

InCyte™ Acquisition Screen

◆ WARNING: Do not run Excel® software, Internet Explorer® browser, or any other 
program on the laptop while using guavaSoft™ software to acquire data from the 
guava easyCyte™ System. guavaSoft™ software requires the full resources of your 
laptop during data acquisition. Running other programs (even if you are not actively 
using them) during a run may interfere with acquisition or interrupt the run.

The Acquisition screen appears when you enter the assay. Use the Acquisition screen to 
acquire data from samples you run on the easyCyte™ System. You can also perform data 
analysis from the Acquisition screen immediately following acquisition.

Event Log

Show/Hide Acquisition Controls

Region List

Gate List

Show Current Run Stats

Show Group Stats

Show Instrument Settings

Show Compensation Controls 

Show Pie Legend 

Show Sample Info

Show Gain Controls

Show Miscellaneous Controls

Tool bar 

Menu bar 

Switch between 
Acquire and Analyse 
control panels

Plate map

Button panel

Plot tool bar

Control panel - displays 
real-time acquisition 
parameters
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Acquisition Buttons

Place the cursor over the icon to display text describing the button.

The following table describes the acquisition buttons. 

Acquisition Button Description

Start New Session File Allows you to select the worklist file, the Method, instrument 
settings, and compensation, prompts you to load the for 
acquisition or the adjust settings, if applicable. 

Adjust Settings Allows you to adjust instrument settings using the appropriate 
sample. 

Acquire Next Sample Begins data acquisition for the next sample. You can make 
changes to the sample information (except for Events to Acquire) 
after acquisition and before clicking Save and Close Current 
Sample. After clicking Save and Close Current Sample, the 
Sample # advances and any changes made to the sample 
information will apply to the next sample.
■ NOTE: When Autostart Acquisition is checked, data 

acquisition starts automatically each time a new tube is 
loaded. Therefore, you do not need to click Acquire Next 
Sample or Save and Close Current Sample.

Save and Close Current 
Sample

Saves the sample data. You can now acquire the next sample.

Next Step Proceeds to the next step in the data acquisition process. The data 
already acquired is saved. 

Retrieve Settings Allows you to recall instrument and analysis settings from a settings 
file and download the settings to the easyCyte™ instrument. If this 
button is disabled, your system administrator may have chosen to 
not allow the retrieval of Methods and instrument settings from 
individual Method and instrument settings files. These settings can 
be retrieved only from an FCS file.

Stop and Close 
Session File

Capillary 
Cleaning Tools

Save 
Settings

Retrieve 
Settings

Save and Close 
Current Sample

Acquire Next
Sample

Adjust SettingsStart New Session Next Step

Abort
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Autostart Acquisition

An automated sample acquisition feature saves you from having to click Acquire Sample 
and Save and Close Current Sample. Check the Autostart Acquisition box to 
automatically start data acquisition each time you load a tube. Be aware that if you use 
the Autostart Acquisition feature, you must enter a Sample ID prior to loading the sample.
■ NOTE: If you are using Autostart Acquisition, it is automatically disabled when you 

click Settings, then Adjust Settings or Retrieve Settings, Quick Clean, or 
Backflush. If you click one of these buttons, you must recheck the Autostart 
Acquisition box to turn on this feature again.

Save Settings Allows you to save the current instrument settings to a separate 
file.

Capillary Cleaning 
Tools

Backflush reverses the flow of fluid out of the flow cell. Perform a 
backflush if the acquisition rate declines and you suspect a clog. 
During acquisition, click Save and Close Current Sample before 
Backflush. Follow a backflush with a Quick Clean. 
Quick Clean cleans the fluid pathway. During acquisition, click 
Save and Close Current Sample before Quick Clean. 

Stop and Close Session 
File

Stops the assay after finishing the acquisition for the current 
sample. After stopping you cannot resume.

Abort Stops the session. The data for the current sample is not saved. 
You cannot resume an assay after you abort. You must start the 
assay from the beginning.

Acquisition Button Description
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Acquire Control Panel 

Sample Info
AutoSave FCS 2.0 Files saves files in FCS 2.0 format, in 
addition to the FCS 3.0 files that are saved.
Autostart Acquisition automatically starts acquisition when 
you load each tube. You do not need to click the Acquire Next 
Sample button. 
Sample Info
• Sample ID: Displays the Sample ID for the individual 

sample. Defaults to the plate well number.
• Sample No: Displays the sample #. This number defaults 

to 1 and advances at the completion of sample acquisition.
• Total count: Displays the number of events to acquire. 

The default is 5000. Total count changes to Gated count if 
you apply a count gate.

• Count Gate allows you to select a gate used as a counting 
gate. All events above the threshold are saved to the file 
whether they are in the gate or not. 

• % Acquired: A progress bar provides an estimate of the 
target event count during acquisition.

• Conc.: Displays the cells/µL that have exceeded the 
threshold.

• Flow Rate: Displays the flow rate selected during the 
adjust settings step (µL/s).

• Volume: Displays the sample volume that is acquired.
• Dilution Factor: Displays the dilution factor. The default is 

1.
• Original Volume: Displays the original sample volume. 

The default is 10.
• Clear Events: Click to clear the display and restart 

acquisition during adjust settings. 
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InCyte™ Analysis Screen

The Analysis screen allows you to analyze data from samples that were previously 
acquired. When you open a data set, the data for the first sample appears. The samples 
within the file are listed in the Data pane. Click the + in front of the FCS file to display the 
list of samples. Click any sample to view the data for that sample. You can also click the 
up/down arrows on the keyboard to select samples.
You can access the Analyse screen by clicking Analyse at the top of the control panel. If 
you display the Analyse screen at the completion of acquisition, the samples you just ran 
are listed in the Data pane. Any gates and marker you set during acquisition will appear. 

Plots

The plots area of the window displays three plots by default. Use the 
Plots menu to change the number of plots displayed. Use the tool 
bar on the right to change the plot type and set regions and gates. 
For more information on plots, see “Plots” on page 4-2. 

Plate Map

The plate map provides a visual representation of the samples 
contained in the dataset. During analysis, click a well in the plate 
map to view the data for that sample in the plots. Place your cursor over a well to display 
the results for that sample. If you are using the HeatMap feature, the plate map provides 
a visual representation of the relative values for each well, or well-to-well variations in 
varying shades of blue. For more information on HeatMapping, see “HeatMap” on 
page 4-38.

Analysis control panel:
• Data pane
• Analysis Methods pan
• Analysed Data pane

Plate map

Tool bar

Undock

Plot type

New Region

Plot gate

New Stat Marker

Edit Overlay List

Zoom
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Analyse Control Panel  

Exiting the Assay
Before quitting the software, be sure to save your current analysis using the Save 
Analysed Group icon in the Analysed Data pane.

1 To quit InCyte™ and return to the guavaSoft main menu, select Quit from the File 
menu.

2 Select Yes in the confirmation dialog. 

Analysis Buttons
Place the cursor over the icon to display text describing the 
button. The buttons have the same function for each pane 
but apply specifically to that pane. 

Data
Displays the open data files, as well as any user-created 
subsets of these files or groups and allows you to select a 
data set or group for analysis.
Analysis Methods
Displays the Analysis Methods for the current experiment. 
Each Analysis Method contains a gate list, a region list, and a 
metric (statistical parameter). InCyte™-acquired files contain 
Methods. For data files acquired using a program other than 
InCyte™, you must create a new Method or open an existing 
Method before you can perform analysis.
Analyzed Data
Displays the FCS file and the associated Method. Created by 
pairing a non-InCyte™–acquired data file with a new or 
existing Method during analysis, or created automatically 
during acquisition using InCyte™. 

DeleteDuplicateSaveOpenNew 
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Files

guava InCyte™ automatically saves a flow cytometry standard (FCS) 3.0 data file, which 
contains the data for all samples within a data set.
Additionally, you can optionally choose to save (or export) the following files:
• a separate Method file
• a separate instrument settings file
• FCS 2.0 or 3.0 files for individual samples for analysis using third-party analysis 

programs 
• list-mode data files

For information on exporting FCS 2.0, 3,0, and list-mode files, see “Exporting Results” on 
page 4-33.

■ NOTE: To keep your computer performing optimally, periodically clear old files from 
your hard drive by archiving the files to a back-up storage location.

Flow Cytometry Standard (FCS) 3.0 Data Files

InCyte™ saves a single FCS file containing all the samples within a data set. The 
extension .fcs is automatically appended to the file name.
FCS files are data files saved in a format compatible with standard flow cytometry 
analysis applications as defined by the Society for Analytical Cytology [Cytometry. 
1990:11(3);323–332]. One FCS 3.0 file is saved for all samples acquired within a data set.

■ NOTE: Always save guavaSoft™ software’s data files directly to the laptop’s hard 
drive during acquisition. Saving acquisition data to an outside network may result in 
data loss. You may copy the file(s) to another location when acquisition is complete. 

Method Files
A Method contain all the analysis components (gates, regions, markers, plots, parameters, 
and statistical setup). When you acquire data using InCyte™, Methods are part of the FCS 
file. Methods can also be saved to a separate file (.gsy). Data files acquired using a 
program other than InCyte™ will not have Methods associated with them.

Instrument Settings Files

Instrument settings are automatically saved with the FCS file. You can also save 
instrument settings to a separate file. The extension .GST is automatically appended to 
the file name you enter. For more information on instrument settings, see “Saving 
Instrument Settings” on page 1-23. 
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Appending and Overwriting Existing Files

If you select the name of an existing dataset name at the start of acquisition, you will be 
prompted to either append or overwrite it. If you append, the sample number defaults to the 
next available number in the existing data file. 

If you append data to an existing file, the instrument settings and analysis gates and 
markers are automatically updated to reflect the settings for the last sample in the file.

■ NOTE: Your system administrator may have configured guavaSoft™ software to 
disable appending and/or overwriting files. If appending only is disabled, you may 
create a new file or overwrite an existing file. If overwriting only is disabled, you may 
create a new file or append to a copy of an existing file. If both appending and 
overwriting are disabled, you must create a new file.

Event Log

Each time you run an assay, guavaSoft™ software saves a log containing a list of all 
events that occurred during the assay. This information is contained within the FCS data 
file. To view this list, click the Event Log icon in the tool bar, or select Tools > Show 
Event Log. A list of all events appears with the date and time the event occurred. 

Allows you to filter the list.
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You can filter the list to view errors, warnings, statuses, and/or actions. Click the 
appropriate check box(es) to display the types of events you wish to view.
Every step the instrument performs, independent of the operator (for example, priming, 
setting thresholds, performing calculations) is logged. Every step the operator performs 
(for example, key presses, selections, changes to gates and markers, logging comments) 
is also logged. During data analysis, although changes to settings are logged, the specific 
details of the change may not be. 
If errors or warnings occur during a run, a message appears in red in the status bar 
indicating that errors/warnings have been logged and how many times they have 
occurred. 
Warnings include:
• Less than 10 particles/µL. Sample is too dilute. Accuracy may be compromised.

• More than 500 particles/µL. Sample is too concentrated. Please dilute or accuracy may 
be compromised.

• The run timed out before enough events were acquired.

• Adjust Settings timed out. Please re-enter Adjust Settings if necessary to complete the 
instrument set-up.

• Maximum velocity exceeded for “x” events (applies only to area/width parameters)

Errors include:
• The pump has reached the end of its stroke. You should run this sample again.
• Error occurred while trying to generate FCS 2.0 file for sample x.

To export the log to a text file, click Export. Select the storage location and enter a file 
name. Then, click Save.

Instrument Settings

InCyte™ saves the instrument settings for each sample acquired. To access the settings 
window select the Analysed Group from the Analysed Data pane, then click the Show 
Instrument Settings tool in the tool bar, or select Tools > Show Instrument Settings. In 
addition to the threshold, gains, and compensation, all of the acquisition information, such 
as date, time, number of events, total volume, concentration, and flow rate, along with 
sample-specific information, like sample ID and number, dilution factor, and original 
volume are saved. 
To copy the window to the clipboard, right-click in the window and select Copy to 
Clipboard.
To export the settings to a CSV file for use in a spreadsheet program, click Export to 
CSV. Select the folder where you want to store the file, enter a file name, and click Save.
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To print the settings, click Print Stats. 

Saving Instrument Settings

Although the instrument settings are automatically saved with the FCS file, guavaSoft™ 
software allows you to save the current instrument settings and analysis gates and 
markers to a separate file. You must perform the adjust setting step before you can save 
a settings file. You can recall this file later to:
• download the instrument settings to the guava easyCyte™ System for acquisition
• apply the gates and markers to data during acquisition

1 Click the Save settings button from the Acquisition screen. 

2 Enter a name for the file, select the directory where you wish to save it, and click 
Save.

Retrieving Instrument Settings

1 Click the Retrieve settings button from the Acquisition screen. 

2 Locate and select the file and click Open. 
The settings are downloaded to the guava easyCyte™ System.

■ NOTE: If you retrieve instrument settings after you perform the adjust settings step, 
you will be prompted to repeat the adjust settings step. You can choose to repeat the 
adjust settings if you wish.
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CHAPTER 2
Getting Started

System Startup and Shutdown

Startup

1 Turn on the power conditioner if it is not already on. Once it is powered on, it can 
remain on.

2 Turn on the laptop computer. 

3 Turn on the guava easyCyte™ System.
The power switch is located on the back of the 
instrument at the lower-right corner (as shown).

4 When the indicator lights turn on, start 
guavaSoft™ software by double-clicking the 
guavaSoft 3.1 application icon on the desktop.
You can also click the Start button, point to 
Programs, then Millipore, then guavaSoft 3.1, 
then click guavaSoft.

5 Ensure the cleaning vial is filled with ICF and 
the waste vial is empty, except for 5 mL of 
bleach.

■ NOTE: If the software detects a communication problem with the easyCyte™ System 
or that the system is not turned on, the following message appears. 

guavaSoft™ will start but you will only be able to access an assay’s analysis mode. If 
you wish to perform acquisition, exit guavaSoft™ software then restart it. If the 

power 
switch
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message appears again, shut down the system. Ensure that the USB cable between 
the computer and the instrument is securely connected before restarting the 
computer. When the computer is finished booting up, turn on the guava easyCyte™ 
System. When the indicator lights are on, start guavaSoft Software.

Shutdown
Clean the easyCyte™ System and leave a tube of water in the sample loader.

1 Run the cleaning procedure at the end of the day. See page 3-2 for complete 
instructions.
After the cleaning procedure is complete, return to the Main Menu and exit 
guavaSoft™. Then turn off the instrument and shut down the laptop, in any order. 

2 Leave the tube of deionized (DI) water loaded on the easyCyte™ System. 
The system can be left in this state.

◆ WARNING: Do not leave Guava® ICF, bleach, or any other cleaning agent on the 
easyCyte™ System overnight or for an extended period of time. Prolonged exposure 
to strong oxidizing agents will damage the flow cell. Always leave a tube of DI water 
on the easyCyte™ System when shutting down the instrument. Change the tube of 
water regularly to ensure it is clean and free of particles.

3 Exit guavaSoft™ software. Do not shut down the guava easyCyte™ System while 
guavaSoft™ software is running.

Quitting guavaSoft™ Software

1 Click Main Menu from any of the guava® assay screens, the Guava Clean screen, or 
the easyCheck screen.

2 Click EXIT in the lower-left corner of the main menu.
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Running the easyCheck™ Procedure
Run the easyCheck™ procedure at the start of each day you use the guava easyCyte™ 
System to ensure the system is performing properly. easyCheck™ averages the results 
from three acquisitions of a guava easyCheck™ Bead sample to determine if the results 
are within the expected range.
■ NOTE: Before running the easyCheck™ Procedure, perform a Quick Clean using 

distilled water to prime the fluid system. If it has been more than a day since you used 
the system, perform two Quick Cleans using water to prime the fluid system.

1 Prepare a 1:20 dilution of guava easyCheck™ Beads. Refer to the easyCheck™ Kit 
package insert for information.

2 Click easyCheck from the main menu.

3 The first time you run the easyCheck™ Procedure, enter the easyCheck™ Bead Lot 
# and Bead Expiration Date (found on the easyCheck™ Beads Reagent vial label), 
and 
Expected Particles/mL in the appropriate fields. Thereafter, enter any necessary 
changes to these values. 
Optionally, you may enter the guava easyCheck™ Kit lot number and expiration date 
(found on the side of the guava easyCheck™ Kit box).
The Expected Particles/mL is typically around 50,000, however check the information 
card that comes with the easyCheck™ Kit for the actual particle count for each new 
lot. The particles/mL corresponds to the concentration of beads in your prepared 
sample where the guava easyCheck™ Bead Reagent was diluted 1:20 with Guava® 
Check Diluent. 

■ NOTE: Your system administrator may have configured guavaSoft™ software to 
require that you enter values in these fields each time you run the easyCheck™ 
Procedure. If the fields are blank when you access the easyCheck screen, you must 
enter the current information.

Enter bead lot #, 
expiration date, and
particles/mL.
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4 Mix the easyCheck™ bead sample using a vortex mixer and load the sample on the 
easyCyte™ System. Click Run 1st Replicate.
The system acquires 1000 events and displays the results in the row for Replicate 1.
Check the Particle Count in the Sample Information control panel. The FSC, SSC, 
BLU-V, GRN-V, YEL-V, RED-V, GRN-B, YEL-B, RED-B, NIR-B, RED-R, and NIR-R 
counts should be within 100 particles of each other when acquisition is complete. 

5 Remove the sample, mix it well using a vortex mixer to resuspend the beads, and 
load it on the easyCyte™ System. Click Run 2nd Replicate.
The system acquires 1000 events and displays the results in the row for Replicate 2.

6 Remove the sample, mix it again to resuspend the beads, and load it on the 
easyCyte™ System. Click Run 3rd Replicate.
The system acquires 1000 events and displays the results in the row for Replicate 3. 
The % CV, average Particles/mL, and average FSC, optional SSC, and fluorescence 
intensities for the three replicates are displayed.

■ ACQUISITION NOTES
• The progress bar provides an estimate of the target event count during the 

acquisition period, which times out after 1 minute.
• If the acquisition rate appears to slow dramatically or there are no particles being 

acquired, the fluid pathway may be blocked. Click Abort, load a tube of deionized 
(DI) water, then click Backflush. When the backflush is complete, load a tube of 
fresh DI water and click Quick Clean. Then, reload the sample and click Adjust 
Settings to start the acquisition process from the beginning.

easyCheck™ Results

The software displays the %CVs and the averages for the particles/mL (bead count), FSC 
and SSC intensities, and all mean fluorescence intensities (MFIs) for the three replicates. 
• If any result for Particles/mL falls outside ±10% of the expected value, the result is 

outside the acceptable range and appears in red. For example, if the actual particle 
count is 50,000, the acceptable Particles/mL range (±10%) is 45,000 to 55,000.

• If any result for MFI falls outside ±15% of the expected value, the result is outside the 
acceptable range.

• If the %CV for Particles/mL is >10%, it appears in red.
• The %CV for FSC and SSC Intensities and MFIs for the three replicates should be 

<5%. 
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Refer to the information card that comes with the guava easyCheck™ Kit for the 
acceptable intensity ranges for each parameter. This information may change from lot to 
lot.
To monitor the instrument performance, look at the average and %CV values for FSC and 
SSC Intensity, and BLU-V, GRN-V, YEL-V, RED-V, GRN-B, YEL-B, RED-B, NIR-B, 
RED-R, and NIR-R MFIs. Refer to “Viewing and Exporting easyCheck™ Results” on 
page 2-5 for information on displaying past easyCheck™ results.
If the Particles/mL (count) for a replicate or the average falls outside the acceptance range, 
or if an intensity value is outside the acceptable range, run Quick Clean (refer to page 3-1). 
Rerun the easyCheck™ Procedure after cleaning is complete. If values continue to fall 
outside the acceptance range, refer to “easyCheck™ Procedure Troubleshooting” on 
page 2-8, for more information.
If the signal intensity for any of these parameters shows significant drift over time beyond 
the range listed, and this change is not correlated to a change in the bead lot, a new flow 
cell, or instrument service, contact EMD Millipore. 

Viewing and Exporting easyCheck™ Results

To display a history of all easyCheck™ runs and view the results for individual runs, click 
Show History at the bottom of the easyCheck screen. The History List control panel 
opens showing a list of all easyCheck™ Procedure runs. To display the results for a 
particular run, click on the run in the list.

Click to display 
the results for a
particular run.
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• Click Log Comment to enter comments related to the run and save these comments 
to the event log. 

• Click View Event Log to display the event log, which lists all errors, warnings, 
statuses, and actions that occurred during the easyCheck™ run. For more information 
on the event log, refer to “Event Log” on page 1-21. 

• Click Show Trend Graph to display a trend graph of the Particles/mL value from the 
last 30, 60, or 90 runs. See “Viewing Trend Data” on page 2-7. 

• Click Print Screen to print the results. A print dialog box appears allowing you to 
select the printer.

• Click Export to Spreadsheet to export the data from all easyCheck™ runs to a 
spreadsheet file. The file contains the average and %CV for each parameter, as well 
as the details for each replicate of all runs.
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• Click Export Service Check File to export the Service Check file. The Service Check 
file is a zipped file containing the detailed results from the most recent easyCheck™ 
run. This file is used by service personnel to troubleshoot your system. If your 
easyCheck™ results continue to fail. Use this export feature to export the file so that 
you can send it to EMD Millipore.

Viewing Trend Data
To view a trend graph of the Particle/mL data, click Show History at the bottom of the 
screen, then click Show Trend Data.
A trend graph appears showing the Particles/mL results from the last 30, 60, or 90 runs. A 
data point appears for each of the three replicate values. The date appears for every 
seventh or eighth time that the easyCheck™ Procedure was run. 

A legend in the lower-right corner of the window lists the information found on the graph. 
A description of the items in the legend appears in the following table. 

Legend Item Description

Replicates Outside Range data point appears as a red triangle (value falls outside the 
high or low, 10% limit lines)

Replicates Within Range data point appears as a black triangle

Median of Replicates a black line connects the median values from each triplicate

Limit High pink line that appears 10% above expected particle count

Target green line at the expected particle count entered

Limit Low pink line that appears 10% below expected particle count

Display data from
last 30, 60, or 90
runs.

Legend
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easyCheck™ Procedure Troubleshooting

Problem Possible Cause Solutions

No event counts appear for 
RED-R and NIR-R.

1. Wrong beads used. 

2. Red laser not operating or 
problem with the signal.

1. Use easyCheck™ beads. 
Do not use Guava® Check 
beads.

2. Contact EMD Millipore 
Technical Support.

One or more Particles/mL 
results falls outside the 
acceptance range (appears 
in red).

1. System is not clean.

2. Incorrect information 
entered in easyCheck™ 
fields.

3. Bead suspension 
incorrectly prepared.

1. Run Quick Clean. If results 
are still outside range, run 
Clean Only.

2. Ensure correct Bead Lot # 
and Expected Particles/mL 
are entered. Refer to 
page 2-3 for information.

3. Prepare fresh bead sample 
and rerun easyCheck™ 
Procedure. Refer to 
easyCheck™ Kit package 
insert for preparation 
instructions.

FSC, SSC, GRN-B, YEL-B, 
RED-B, NIR-B, RED-R, 
and/or NIR-R intensity is 
>10% outside the 
acceptable range.

1. System is not clean.

2. Problem with detector or 
laser.

1. Run Quick Clean. If results 
are still outside range, run 
Guava® Clean. 

2. If problem persists, contact 
EMD Millipore Technical 
Support. 

Particle counts for FSC, 
SSC, GRN-B, YEL-B, 
RED-B, NIR-B, RED-R, 
and/or NIR-R intensity is 
not within 100 events of 
each other.

1. If FSC count is low, 
capillary may not be 
seated correctly. 

2. If any of the counts is low, 
possible problem with 
detector.

1. Remove metal plate. 
Unscrew tubing from top of 
flow cell and firmly push 
down on top of flow cell 
assembly. 
If problem persists, contact 
EMD Millipore Technical 
Support.

2. Rerun easyCheck™ 
Procedure. If counts are 
still low, contact EMD 
Millipore Technical 
Support. 
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Few events, as indicated in 
Particle Count section of 
Sample Information control 
panel.

1. Clogged flow cell.

2. Insufficient sample 
volume.

3. Beads in suspension have 
settled.

1. Remove sample, load 
bleach, click Backflush. 
Follow with Quick Clean 
using DI water.

2. Minimum sample volume is 
90 µL.

3. Click Abort. Remove 
sample, mix, reload, and 
reacquire.

No events, as indicated in 
Particle Count section of 
Sample Information control 
panel.

1. Sample tube not properly 
loaded.

2. Insufficient sample 
volume. 

3. No beads in sample.

4. Clogged flow cell.

5. Broken flow cell.

6. Sample pump not 
working.

7. Laser is not operational.

8. Loose fitting on minstac 
tubing (under metal plate).

1. Ensure tube is loaded and 
loader assembly is up.

2. Minimum sample volume 
is 90 µL.

3. Ensure correct sample is 
loaded.

4. Remove sample, load 
bleach, click Backflush. 
Follow with Quick Clean 
using DI water.

5. Remove flow cell and 
inspect for damage. 
Replace, if necessary. 

6. Run Quick Clean and 
watch for fluid in waste 
vial.

7. Contact EMD Millipore 
Technical Support.

8. Ensure tubing connector is 
secure.

Message:
The login user does NOT 
have read/write permission 
to the file 
GuavaCheckLog.csv in the 
Log folder. Contact the 
system administrator for 
assistance.

The user was not assigned 
access control to the system.

Contact your system 
administrator for user access 
to the software.

Problem Possible Cause Solutions
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CHAPTER 3
Cleaning and Maintenance

Depending on the type of cleaning you wish to do, guavaSoft™ software offers different 
cleaning options—Quick Clean, which you can use as often as you like throughout an 
assay or anytime, and Guava® Clean, a more thorough cleaning, which you run at the 
start and end of each day to thoroughly clean the fluid system.
To clean the outside of the instrument, wipe it down with a soft cloth moistened with 70% 
alcohol. Follow with a cloth moistened with water. 

◆ WARNING: To avoid exposure to laser radiation or electric shock, DO NOT open the 
easyCyte™ System or attempt to perform any internal maintenance. There are no 
user serviceable parts.

Running Quick Clean
Quick Clean is a short cleaning cycle that allows you to clean the fluid system during and 
after an assay, or as often as you like throughout the day. If you are running lots of 
samples or particularly dirty or adherent cells, run Quick Clean frequently. The Quick 
Clean feature, which is accessible from the easyCheck™ and all guavaSoft™ Assay 
screens, prompts you for a tube of cleaning solution. 

1 Load one of the following solutions on the easyCyte™ System:
• deionized water to quickly flush out the fluid system
• undiluted Guava® ICF to clean the system, followed by water to rinse
• a 10% bleach solution in Guava® ICF (1 part bleach in 9 parts Guava® ICF; for 

example, 100 µL bleach plus 900 µL Guava® ICF) to clean and sanitize, followed 
by water to rinse

2 Click Quick Clean from any of the guava® assay screens. From guava InCyte™, click 
the Capillary Cleaning Tools button and select Quick Clean.
A message appears prompting you to load a tube of cleaning solution. Ensure the 
tube is loaded and click OK. 
The solution is pumped through the system for approximately 30 seconds.

3 If you used water, you are finished. If you used Guava® ICF, either straight or with 
bleach, load a tube of water and click Quick Clean again to rinse.

You may continue running samples, or leave the tube of water on the easyCyte™ System 
until you are ready to use the system again.
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Running Guava® Clean
Run Guava® Clean to clean the instrument at the beginning and end of the day, as well as 
between assays if a thorough cleaning is needed. You can also use Guava® Clean to 
prime the fluid system or if you suspect there is air in the fluid lines. Fill the cleaning vial 
and sample tube with water and run Guava® Clean to prime. Guava® Clean takes 
approximately 15 minutes to complete. While it is running, the lasers are turned off. 
Always leave a tube of deionized water on the easyCyte™ System at the end of the 
cleaning cycle.

1 Click Cleaning from the main menu.
The Guava Clean screen appears. 

2 Click Start Cleaning.
A dialog box appears, prompting you to load a tube of water. 

3 Load a 1.5-mL tube filled with DI water in the sample loader and click OK.
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After approximately 4 minutes, a message appears prompting you to load a tube of 
cleaning solution. 

4 Load a tube half-filled with a 10% bleach solution in Guava® ICF (1 part 100% bleach 
in 9 parts Guava® ICF) and click OK.
After approximately 3 minutes, a message appears prompting you to load a tube of 
clean water. 

5 Load a tube of fresh water and click OK. 
If you notice air moving through the cleaning vial tubing, when the cleaning cycle is 
complete, check the connectors holding the tubing to ensure they are tight.
After approximately 5 minutes, a message appears prompting you to load the tube of 
clean water. 

6 If you are shutting down the instrument, place a tube of deionized (DI) water on the 
easyCyte™ System. Return to the Main Menu and exit guavaSoft™. Then turn off the 
instrument and shut down the laptop, in any order. 

◆ WARNING: Do not leave Guava® ICF, bleach, or any other cleaning agent on the 
easyCyte™ System overnight or for an extended period of time. Prolonged exposure 
to strong oxidizing agents will damage the flow cell. Always leave a tube of deionized 
water on the easyCyte™ System after cleaning and when shutting down the system. 
Change the tube of water regularly to ensure it is clean and free of particles. 
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Backflushing the Fluid System
The backflush feature reverses the flow of fluid out of the flow cell. Click the Backflush 
button, located on each assay screen and the easyCheck screen, when you suspect that 
the fluid pathway is clogged or blocked. 

1 If you suspect a clog, click Abort.

2 Remove the sample tube and load a tube of 20% bleach. 

■ NOTE: If you are running the easyCheck™ Procedure, use water when backflush-
ing the system.

3 Click Backflush from any of the guava® assay screens. From guava InCyte™, click 
the Capillary Cleaning Tools button and select Backflush.
A message appears instructing you to load a tube of water or bleach. Ensure the tube 
is loaded and click OK. 

4 If you used bleach in step 2, load a tube of deionized water and click Quick Clean to 
rinse any residual bleach from the capillary. 

5 Throw out the tube you used in step 2, as it may contain debris from the backflush.

6 Replace the sample and click Acquire Next Sample (If you are running the 
easyCheck™ Procedure, start from the adjust settings step). 

Filling the Cleaning Solution Vial
Fill the cleaning solution vial with Guava® ICF when it is approximately 1/4 full. The 
cleaning solution is aspirated through the tubing in the vial. Do not allow the vial to empty. 
Check it frequently to ensure it does not run dry. This will create air bubbles in the fluid 
system and require that you prime the system with water. One vial of cleaning solution will 
allow you to perform approximately 15 cleaning cycles.

1 Gently pull up on the vial to remove it from the bracket. 

Slide cleaning solution vial out of bracket.
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2 Unscrew the vial from the cap. 

3 Fill the vial with Guava® ICF to just below the bottom of the cap. Do not overfill the 
vial.

4 Replace the vial on the cap assembly and install the vial on the system. 
Ensure the tubing that goes into the vial is still attached to the cap.

Emptying the Waste Vial
Empty the waste collection vial at the end of each day, or as needed.

◆ WARNING: Handle all biological specimens and materials they come in contact with as 
if capable of transmitting infection. Dispose of these materials using proper 
precautions in accordance with federal, state, and local regulations. 

1 Gently pull up on the vial to remove it from the bracket. 

2 Unscrew the vial from the cap. 

Unscrew cleaning solution vial.

Slide waste vial out of bracket.

Unscrew waste vial.
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■ NOTE: Fluid may seep from the cap while it is disconnected from the vial. To prevent 
waste fluid from dripping on the work surface, place the cap in a small container or on 
an disposable, absorbent pad. 

■ NOTE: If you notice a leak on top of the waste vial cap, tighten the connector on the 
cap.

3 Empty the contents according to your local and state biohazardous waste disposal 
guidelines.

4 Rinse the waste vial with water.

5 Add approximately 5 mL of bleach to the waste vial, replace the vial on the cap 
assembly and install the vial on the easyCyte™ System. 

Cleaning the Flow Cell

About the Flow Cell

The flow cell assembly consists of the shuttle, the 
capillary, and the minstac tubing. The shuttle 
houses the optical window, where the laser beam 
intersects the sample. When handling the flow 
cell assembly, grasp it towards the top of the 
shuttle, where the minstac tubing is attached, to 
avoid getting fingerprints on the optics window. 
When installing a flow cell, ensure this tubing 
connection is tight to avoid fluid leaking from the 
top of the shuttle. 
A flow cell removal tool is provided and can be 
used to remove the flow cell. A tightening tool is 
also provided and can be used to tighten the 
minstac tubing to the instrument during flow cell 
installation.

Using the Syringe Tool to Clean the Flow Cell Assembly

Use the syringe assembly tool to clean the flow cell. When removing the flow cell, handle 
it with care. The capillary tube is fragile; avoid touching it unnecessarily. Do not force the 
flow cell into the receptacle. However, slight pressure may be required to properly seat 
the flow cell once it has been inserted into the receptacle.

◆ WARNING: To avoid exposure to laser radiation, turn off the power to the easyCyte™ 
System before attempting to remove the flow cell.

1 Lower the sample loader arm.

2 Remove the metal plate from the top of the instrument.

minstac 
tubing

shuttle

capillary

optics 
window
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3 Remove the tubing from the clamp and disconnect it from the instrument. 

4 Remove the flow cell by grasping it at the top with your fingers and pulling straight up. 
Do not pull up on the tubing.
You can also use the flow cell removal tool to remove the flow cell. 
• Grasp the flow cell with the removal tool by placing the clamps into the cutouts at the 

top of the flow cell, as shown.
• Pull the tool straight up to remove the flow cell. 

5 Fill the syringe cleaning tool with water or Guava® ICF. Connect the syringe to the 
minstac tubing on the flow cell. Ensure the fitting is tight. 

6 Use a Kimwipe® wipe to hold the flow cell at the top of the shuttle to capture fluid that 
may leak. Apply gentle, steady pressure to the plunger and watch as the fluid flows 
from the tip of the capillary. 
• Make sure the fluid stream is straight. If it is not straight, the tip of the flow cell may 

be chipped or there may be a partial clog in the flow cell.

cutouts in flow cell
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• Check the capillary to ensure there are no leaks along the length of it.
• Make sure fluid is not leaking where the tubing is connected at the top of the flow 

cell.

7 Unscrew the syringe from the minstac tubing. Leave the minstac tubing attached to 
the flow cell.

8 If you noticed leaks at the tubing connection and you 
have the tool shown at the right, use the tool to 
tighten the tubing connection. A tight connection 
ensures that fluid will not leak from the top of the 
flow cell. 
• Point the tool’s threaded stem up (away from the 

flow cell) and insert the tubing connector into 
clamp end of the removal tool. 

• Squeeze the handles of the tool to secure the flow 
cell, while tightening. 

• Tightening is sufficient when you feel the tool 
slipping on the connector.

If you don’t have the tool shown at the right, use 
your fingers to hand-tighten the tubing connection.

9 Use a Kimwipe® wipe to dry the end of the tubing that you disconnected from the 
syringe. 

10 If the flow cell is clean and intact, reinstall it. If it is damaged or not functioning 
properly, discard it and replace it with a new flow cell.
• Install the clean (or new) flow cell by correctly positioning it vertically above the 

instrument and carefully lowering it into the receptacle. The flow cell fits only one way 
into the receptacle. Avoid bumping the capillary as you install it. 

clamped end 
of tool over 
tubing 
connector

Dry connector before reinstalling the flow cell.
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• Use your fingers to push down on the top of the flow cell on either side of the tubing 
until the flow cell clicks into place. Do not press down on the tubing at the top of the 
shuttle. Press down until the flow cell stops and won’t go any farther. 

11 Connect the tubing to the instrument. Make sure the tubing is screwed on tightly. If 
necessary, use the tightening tool. Then insert the tubing into the clamp. 

12 Ensure that the cleaning solution vial is full, then run Quick Clean to prime the system. 
If starting the instrument after it has been shut down, run Guava® Clean to prime. 
Watch the tubing during the Quick Clean to ensure no bubbles appear in the tubing.

13 To ensure that the flow cell was correctly installed, run the easyCheck™ procedure. 
While the first replicate is being acquired, watch for bubbles in the minstac tubing. If 
bubbles or leaks are visible, the tubing may not be adequately tightened. 
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Replacing the Flow Cell
You can replace the flow cell if it becomes damaged or clogged so severely that 
backflushing and cleaning the system do not fix the problem. When replacing the new 
flow cell, handle it with care. The capillary tube is fragile; avoid touching it unnecessarily. 
Do not force the flow cell into the receptacle.

◆ WARNING: To avoid exposure to laser radiation, turn off the power to the easyCyte™ 
System before attempting to remove the flow cell.

1 Lower the sample loader arm.

2 Remove the metal plate from the top of the instrument.

3 Remove the minstac tubing from the clamp and disconnect it from the instrument. 

4 Remove the flow cell by grasping it at the top with your fingers and pulling straight up. 
Do not pull up on the tubing.
You can also use the flow cell removal tool to remove the flow cell.
• Grasp the flow cell.with the removal tool by placing the clamps into the cutouts at the 

top of the flow cell, as shown.
• Pull the tool straight up to remove the flow cell. 

cutouts in flow cell
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5 Install a new flow cell by correctly positioning it above the instrument and carefully 
lowering it into the receptacle. The flow cell fits only one way into the receptacle. Keep 
the flow cell completely vertical and avoid bumping the capillary against the 
instrument or sides of the receptacle. Use your fingers to press down on the top of the 
flow cell on either side of the tubing until the flow cell clicks into place. Do not press 
down on the tubing at the top of the shuttle. 

6 Connect the tubing to the instrument, then insert the tubing into the clamp. 

7 Ensure that the cleaning solution vial is full, then run Quick Clean to prime the system. 
If starting the instrument after it has been shut down, run Guava® Clean to prime.

8 To ensure that the flow cell was correctly installed, run the easyCheck™ procedure. 
While the first replicate is being acquired, watch for bubbles in the minstac tubing. If 
bubbles or leaks are visible, the tubing may not be adequately tightened.
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Replacing the Fuses
The AC fuse is located on the rear panel to the right of the AC power cord connector.

◆ WARNING: Turn off the power switch at the back of the instrument and disconnect the 
power cord. 

1 Remove the fuse holder cover using a small screwdriver and pivot to expose the fuse 
carrier.

2 Pull out the fuse carrier.

3 Carefully remove the fuses and replace with new fuses. Use the same type and rating 
as listed in the Specifications section.

■ NOTE: If you have a 110 V supply you will need to replace a single fuse. If you 
have a 220 V supply you will need to replace two fuses.

4 Insert the fuse carrier back into the fuse holder. The fuses will face the inside of the 
fuse holder.

5 Replace the fuse holder cover. 

6 Reconnect the power cord and turn on the main power switch.

fuse holder

power switch

AC power cord connector
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Returning the System for Service
Contact EMD Millipore Technical Support for the Decontamination Form and instructions. 
The form must be returned via e-mail before you can return the instrument. A return 
authorization (RMA) number will be issued to you. Write this number on the outside of the 
shipping box. If you did not save the original shipping box, you can order one (see 
Appendix C: Ordering Information).

1 Perform the Guava® Clean procedure (see “Running Guava® Clean” on page 3-2).

2 Clean and disinfect the cleaning solution vial and waste vial.

3 Power off the laptop and instrument.

4 Disconnect the laptop, instrument, and power conditioner.

5 Pack the laptop and power cord in the laptop box.

6 Pack the USB cable, extension cable, and power cord in the accessory box. 

7 Remove the flow cell from the instrument. Use the syringe cleaning tool to flush it with 
water, and then flush it with air. Store the flow cell in the capillary box. For information 
on cleaning the capillary, see “Using the Syringe Tool to Clean the Flow Cell 
Assembly” on page 3-6.

8 Tape the capillary hatch closed.

9 Place the instrument in the shipping bag and secure the bag. Be sure to include the 
cleaning solution and waste vials.

10 Place the instrument in the shipping box. Always use two people to lift the instrument.

11 Place the blue shipping foam over instrument. Place the accessory box on top.

12 Place the cover on the box and insert the white locks into the holes. 
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CHAPTER 4
guava InCyte™ Assay

Introduction
guava InCyte™ was developed to be an open assay module providing all the basic tools 
for sample acquisition and data analysis. The guava InCyte™ module allows you to 
acquire and analyze up to ten fluorescence parameters in combination with forward 
scatter (FSC) and side scatter (SSC), as well as area, width, and time.
The instrument is configured to detect the following fluorochromes or fluorochromes with 
similar fluorescence. The filter is listed first, followed by the laser. For example, Blue-
Violet (BLU-V) is the filter for the blue fluorescence emission off the violet laser.
For a complete list of the fluorochromes compatible with each laser, see "Fluorochromes" 
in the Specifications section.
Filters off the violet laser: 
• Blue-Violet (BLU-V) parameter – DAPI, Brilliant Violet 421, Pacific Blue, Cascade 

Blue, or Alexa Fluor® 405
• Green-Violet (GRN-V) parameter – Brilliant Violet 510 or Pacific Green
• Yellow-Violet (YEL-V) parameter – Brilliant Violet 605 or QDot 565
• Red-Violet (RED-V) parameter – Brilliant Violet 650 or eFluor 650

Filters off the blue laser:
• Green-Blue (GRN-B) parameter – FITC, GFP, or Alexa Fluor® CF-488
• Yellow-Blue (YEL-B) parameter – Phycoerythrin (PE)-based, Cy3, Alexa Fluor® 532, 

propidium iodide (PI), TRITC, and DS Red reagents
• Red-Blue (RED-B) parameter – PE-Cy5, PerCP, 7-AAD, PE-Cy5.5, and PI
• NIR-Blue (NIR-B) parameter – PE-Cy7

Filters off the red laser:
• Red-Red (RED-R) parameter – Allophycocyanin (APC), Cy5, or Alexa Fluor® CF-

647.
• NIR-Red (NIR-R) parameter – APC-Cy7, or APC-Alexa Fluor® 750
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InCyte™ Application Window
The application window opens displaying three plots. A tool bar at the left edge of the 
window allows you to access most of the application controls (see Figure 4-1). You can 
find these same options in the Tools menu in the menu bar.
The control panel displays the controls for acquiring and analyzing data. Click Analyse or 
Acquire to display the desired control panel. Click in the top bar (above the Analyse and 
Acquire buttons) to drag the floating control panel to any area of the screen or dock it on 
the right side of the window. To redock it on the left, double-click the bar at the top of the 
panel. To hide the control panel, click the X in the top-right corner. To redisplay the panel, 
choose Tools > Show/Hide Acquisition Controls from the menu bar, or click the 
Acquisition Controls icon in the tool bar on the left edge of the application window. Place 
your cursor over any button in the Analyse or Acquire button panel to see text describing 
the button. 

Figure 4-1 InCyte™ application window – Acquisition screen

Plots
Use the Plot menu in the menu bar to set up the plot layout. Select the number of plots to 
display (2x2 to 5x5 represents the number of plots displayed down vs across). Up to 24 
plots can be displayed at one time. 

Tool bar 

Menu bar 

Switch between 
Acquisition and 
Analysis

Plate map

Button panel

Plot tool bar

Displays real-time 
acquisition parameters
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Plot Tool Bar
• Use the Undock icon to detach and enlarge the plot. The plot 

will detach in its own floating window. Drag the bottom-right 
corner to increase the size of the plot window. Copy the 
zoomed plot to the clipboard for higher resolution plots. To 
reattach the plot, click the Undock icon again or the X in the 
top-right corner. 

• Use the Plot type icon to select Dot Plot, Histogram, or 
Contour Plot, and to adjust settings such as smoothing 
histograms and contours and selecting the dots to display in 
dot plots. Contour plots can be used only during analysis. See 
“Changing the Display of Data in Plots” on page 4-3 for 
information.

• Use the New region and Plot gate icons to create regions and apply gates, 
respectively. See “Regions, Gates, and Statistics” on page 4-19.

• New Stat Marker is described in “Stat Markers” on page 4-26. Edit overlay list is 
described in “Overlaying Histograms” on page 4-49. 

• To change the plot parameters once data is displayed, click the parameter name 
and select the new parameter from the pop-up menu. To customize a parameter 
name, see “Changing Parameter Names” on page 4-5. 

• To copy a plot to the clipboard, right-click the plot and select Copy Plot to 
Clipboard.

• Use the Zoom icon to zoom an area of the plot. Click and drag a rectangle in any 
direction to encompass the population you wish to zoom in on. To scroll the data in 
the plot, click the icon, then hold down the Shift key while you click and drag. To 
unzoom, click the Zoom icon again, then press and hold the Ctrl key while you click 
anywhere in the plot.

Changing the Display of Data in Plots

You can make the following changes to the display of data 
in these plots. The settings are saved with the Analysed 
Group. Click the Plot Type icon in the plot tool bar and 
select Plot Settings. 

Undock

Plot type

New region

Plot gate

New Stat Marker

Edit overlay list
(histograms only)

Zoom
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• Set the number of dots displayed in a dot plot
 Use the slider to set the number of dots from 1 to 100%. The default is 100%. 

• Smooth histograms
Use the slider to set the amount of smoothing (sigma) from 0 to 5.0, where 0 is no 
smoothing. The default is 1.5. 

• Smooth contour plots
You can adjust both the number of levels from 5 to 20, and the amount of smoothing 
(sigma) from 0 to 5.0, where 0 is no smoothing. The defaults are 10 and 1.5, 
respectively. Contour plots can be created during analysis only.  
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Changing Parameter Names

You can change the default long (or stain) name of any parameter. The short name, for 
example, GRN-B-H, is fixed and will still appear in the plots in parentheses after the new 
long name.

1 Choose Application > Change Parameter Names 
from the menu bar. 
The Parameter Names dialog box appears. Area and 
width are listed only if they were selected during the 
adjust settings step prior to acquisition.

2 Double-click the existing name in the Long or Stain 
Name text field and type in the new name, or use the 
tab key to highlight the desired field and begin typing 
the new name.
The short name will appear in parentheses following the 
long name under the plots.

3 Click Update. 

Pie Legend

The Pie Legend contains the HeatMap legend and the IC-50 
application. The HeatMap legend (circle) is used to display the data 
results for each Analysed Group (data + Method) in the plate map. 
Use the Show Pie Legend icon in the tool bar to display this 
workspace. 
The HeatMap legend shows one sector by default. You can create up 
to six sectors for six experiments. Each sector will have a data file (or 
group) paired with an Analysis Method. To divide the legend into 
multiple sectors click N=2, 3, etc. To clear a sector, right-click it and 

Show Pie Legend
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select Clear Sector. For more information on Heatmapping, see “HeatMap” on page 4-
38. 

• N allows you to select the number of sectors you want to display. Sectors are 
numbered (1-6) with each new sector entering the upper-left portion of the circle.

• Threshold allows you to apply upper and/or lower limits on statistical values to 
eliminate data above or below the thresholds. The Current panel is only functional when 
one sector is being displayed, or when multiple sectors are used but the HeatMap 
legend is in single-mode display. See “Thresholds” on page 4-43 for information.

• The IC-50 application allows you to rapidly convert time course or dose response 
studies into standard curves for the calculation of compound IC50/EC50 values. See 
“IC-50/EC-50” on page 4-44 for more information.

guava InCyte™ Sample Acquisition 
1 Open guavaSoft™ software by double-clicking the guavaSoft™ icon on the desktop.

2 Click InCyte from your list of Favorites, or select InCyte™ from the Program Search 
list and click Launch. 
The guava InCyte™ window opens in Acquisition mode, if the easyCyte™ System is 
turned on. The top portion of the control panel contains 10 buttons used to control 
acquisition, adjust, retrieve and save instrument settings, and select cleaning options. 

Select the number of sectors to display.

Set minimum and/or maximum thresholds to eliminate 
data above and/or below the thresholds.

Drag and drop a data file (or group) and an Analysis 
Method to the HeatMap legend for analysis.

Click to change the display from single- to multi-sector 
display. Up to six sectors can be displayed.
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For information on the control panel, refer to “Acquire Control Panel” on page 1-17. 

3 Prepare samples for acquisition in tubes.

4 Click the Start New Data Session File button. 
A dialog box appears allowing you to select a data file name and location, Analysis 
Method, and instrument and compensation settings. 

5 An FCS data file will be named and stored automatically. The default storage location 
is My Documents. The default file name is the date and time. To change the defaults, 
click Select Output FCS file, enter the new information, and click Save.

 NOTE: Always save guavaSoft™ software data files directly to the system’s hard drive 
during acquisition. Saving data to a network or location other than the computer’s 
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hard drive may result in data loss. You may copy the file(s) to another location when 
acquisition is complete. 

6 Select the information you want to retrieve:

 NOTE: Your system administrator may have configured guavaSoft™ software to 
disable the retrieval of Methods, instrument settings, and compensation settings 
from Method files and individual instrument settings files. If the Settings and 
Compensation retrieval options are disabled, you will not be able to adjust 
instrument settings. However, you can retrieve settings and Methods from a single 
FCS file.

•  Method – either from an InCyte™ FCS file or a saved Method file (.gsy). Click 
Choose, locate the file, then click Open. 
The FCS or Method file must be from InCyte™, version 3.0, or later. If you do not 
choose a Method file, a default one will be created automatically.
If you select an FCS file to obtain the Method, you can also retrieve the instrument 
settings and compensation settings that were saved with that FCS file. 

• instrument settings – either from an InCyte™ FCS file or a saved instrument 
settings file (.gst). Click Choose, located the file, then click Open. 
The FCS or instrument settings file must be from InCyte™, version 3.0, or later.

• compensation settings – either from an InCyte™ FCS file or a saved instrument 
settings file (.gst). Click Choose, located the file, then click Open.
The FCS or instrument settings file must be from InCyte™, version 3.0, or later. 

7 Click Adjust Settings.
If you retrieved instrument settings and you wish to skip the adjust settings step, click 
Acquire to proceed to acquisition.
A dialog box appears prompting you to load the control sample. 

Adjusting Instrument Settings

During adjust settings, if you need to change the sample for a particular step, such as 
compensation, click the Next Step button, then Adjust Settings, then load the sample, and 
click OK.

8 Mix a stained cell sample and load it on the easyCyte™ System.
We recommend using a stained negative or isotype control sample for the initial 
adjustments. 

9 Ensure your sample is loaded and click OK in the load samples dialog. 
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10 Check the Conc (Cells/µL) value in the Sample Info pane and ensure that it is less 
than or equal to 500.

 NOTE: If the value is greater than the high limit for the corresponding flow rate, dilute 
the sample with the appropriate buffer to lower the concentration and minimize the 
risk of coincident events. For optimal performance, we recommend a concentration 
of 250 cells/µL or lower. 

11 To fine tune the settings, you can make the following 
adjustments using the Gain, Compensation, and 
Miscellaneous Controls. Open each instrument adjustment 
window using the Tools menu or the icons in the tool bar (left 
edge of the application window). If necessary, click the 
window’s title bar to drag the window to a new location. 
• Use the Miscellaneous Controls to set the Flow Rate to 

Very Low (0.12), Low (0.24 µL/s), Medium (0.59 µL/s), or High (1.2 µL/s). The 
default flow rate is Medium. Set the Refresh Rate to the maximum number of 
events (100–5000) you want to display.

 NOTE: If you change the flow rate during the adjust settings step, we recommend 
that you repeat the adjust settings step at the new flow rate to ensure that the 
markers and threshold are set correctly.

• If you wish to save area measurements for all parameters, select Enable Area 
Mode. Area will be acquired for all parameters. The threshold parameter, which is 
always height, will appear in height (H) at the bottom of the plot parameters list. 
Use the Area/Width menu if you want to acquire width for one parameter.
If you want to acquire area for only one parameter, do not check the Enable Area 
Mode check box. Instead, select the parameter from the Area/Width menu. The 
area and width for the selected parameter will be acquired. Use the Area and/or 
Width Scaling Control sliders to reduce or amplify the signal so that the cells are 
visible and on scale.  

• The time parameter is saved automatically. Use the Time Scaling Control slider to 
set the maximum time (in seconds) to record. Adjust the y-axis (count) scale on the 
plot, if necessary. 

Compensation Controls

Gain Controls

Miscellaneous Controls

Select Enable Area Mode to acquire
pulse area for all parameters.

Or, select an individual parameter 
from the Area/Width menu to acquire
area and width for that parameter.
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• Set up the type of plots and parameters you wish to display. If you retrieved a 
Method, the plots are configured with the regions and gates defined in that Method. 
Modifications may be necessary to accommodate the new data. For more 
information on plots and changing the parameters, see page 4-2.

• Use the Gain Controls to select the Threshold parameter from the drop-down 
menu.

• Use the Gain Controls to adjust the gains (using the sliders or the arrow keys on 
the keyboard) to a value from 1 to 1024. You can also type a numerical value in any 
of the Gain text boxes to adjust the settings. Adjust so that the negative population 
(or isotype) is positioned in the lower-left corner of the fluorescence plot and the 
cells are evenly distributed in the lower-left quadrant. Start from a lower gain setting 
and gradually increase the value. For greater detection and sensitivity across a 
broad range of fluorescence, the overall gain range can be adjusted using the High 
check box. By default, all boxes are checked. If further adjustment is needed or the 
signal is at its maximum, remove the checks from the High Calibration check boxes 
and allow the gain to stabilize for 2 to 5 seconds. 

 NOTE: Use the Clear Events button in the Sample Info panel to clear the display.
• To acquire 4 log decades, remove the check from the 5 decade Acquisition check 

box.
• To acquire 4 log decades, remove the check from the 5 decade Acquisition.
• If the red and/or violet laser is not needed for your application, you can turn it off by 

removing the check. For information on the laser and optical filters required to 
detect the various fluorochromes, see "easyCyte Lasers and Fluorescent Filters" in 
Specifications. 

 NOTE: Selecting and deselecting lasers will result in changes in laser power. 
Additionally, %CVs may vary slightly depending on the laser mode selected for 
acquisition. 

• To adjust the threshold, use the slider or click and drag the threshold marker (dotted 
red line) up or down the axis of the dot plot displaying the threshold parameter until 
the desired amount of debris or other unwanted events are eliminated below the 
threshold. You can also enter a numerical value in the text box and press Enter on 
the keyboard. 

• To adjust compensation, load the appropriate sample, and proceed with the 
compensation adjustments. You may want to adjust each compensation setting 
individually using single-stained controls.
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Use the Compensation Controls to select the radio button for the parameter you 
wish to subtract, then use the slider to adjust the percentage of the overlapping 
signal to be removed from the detector. 
For more details on specific compensation adjustments and examples, see 
“Performing Manual Compensation” on page 4-34. 

12 You may set regions and gates prior to acquiring the samples. See “Regions, Gates, 
and Statistics” on page 4-19” and “Gates” on page 4-22 for information. 

If you wish to apply a count gate, create and define the gate, then select it from Count 
Gate drop-down menu under Sample Info. You can select the count gate from the 
Adjust Settings screen only.

You can also view real-time statistics during the adjust settings step. See “Stat 
Markers” on page 4-26 for information on creating stat markers and viewing the real-
time statistics.

13 When you are finished adjusting settings, click the Next Step button. 
If necessary, you can repeat the adjust settings step to ensure that other samples 
(such as another positive control) are on scale, appropriately positioned, and 
compensated, by clicking Adjust Settings, loading the sample, and clicking OK.
If you wish to save the instrument settings, click the Save Settings icon in the control 
panel. Enter a file name and click Save to save a .gst file. Once the worklist is 
complete you can no longer save the instrument settings.

14 Vortex the first sample and load it on the instrument.

15 Enter the number of events to acquire in the Sample Info panel.
The default number of events to acquire is 5000.
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16 If you want to identify individual samples or sets of samples, enter an optional ID in 
the Sample ID field.
The sample ID may be any text up to 40 characters long. If you do not enter a sample 
ID, the default sample number will be used as the sample ID, for example, Sample #1, 
Sample #2, etc.

 NOTE: If you click Autostart Acquisition and wish to enter a sample ID, type the ID 
into the Sample ID field after acquisition is complete and before loading the next 
sample.

17 Click the Acquire Next Sample button.
The system acquires the first sample. 

 ACQUISITION NOTES
• If you select Autostart Acquisition, acquisition automatically starts when you load 

each tube. You do not need to click Acquire Next Sample. Autostart Acquisition 
automatically turns off if you click any of the following: Adjust Settings, Retrieve 
Settings, Quick Clean, or Backflush. You must recheck the box to continue using 
the feature.

• If the acquisition rate appears to slow dramatically, 
the fluid pathway may be blocked. Click the Abort 
button, then click Capillary Cleaning Tools and 
select Backflush. Load a tube of 20% bleach and 
click OK. When the backflush is complete, select 
Quick Clean. Load a tube of DI water and click 
OK. Click Acquire Next Sample to continue. 
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• The progress bar provides an estimate of the target event count during the 
acquisition period, which times out after 1.75 minutes (high flow rate), 3.5 minutes 
(medium flow rate), 7 minutes (low flow rate), or 10 minutes (very low flow rate).

 NOTE: If a clog or loss of signal is detected, we recommend removing the clog by 
running a Quick Clean with water, then a Quick Clean with ICF, followed by 
Backflush into an empty tube, then another Quick Clean with ICF, and a final Quick 
Clean with water.

18 Click Save and Close Current Sample.
You may still enter or change the Sample ID for the current sample before clicking 
Save and Close Current Sample.

19 Repeat steps 14 through 18 for the remaining samples.

20 Click the Stop and Close Session File after the last sample.

21 When you are finished, click Capillary Cleaning Tools and select Quick Clean. Load 
a tube of deionized water and click OK. If you ran blood samples, run two Quick Clean 
cycles with water, followed by one cycle using ICF, and finally one cycle using water to 
rinse.

At the completion of the run, a copy of the Data, Method, and AnalysedGroup are 
automatically loaded into the Analysis control panel. guava InCyte™ saves the data for all 
samples as a single FCS 3.0 file to the specified location. 
The FCS file contains:
• the acquired data for all tubes in the run
• the Method (plots, regions, gates, and metrics, if applicable)
• an AnalysedGroup (the data paired with the Method)
• instrument settings (gains, compensation, miscellaneous settings)

guava InCyte™ Analysis 
InCyte™ Software allows you to open and analyze any guava® FCS 3.0 data file, 
regardless of the software module used for acquisition. An analysis-only version of 
InCyte™ 3.0 is available for MacOS 10.6 and later. See the readme file for more 
information and details on where to go to download the software.
You can proceed to analysis from the acquisition screen.
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The Analysis Panes

Click the Analyse button at the top of the control panel to access the Analyse control 
panel. If you click Analyse from the Acquisition screen after acquiring a sample, the data 
from the last sample acquired is displayed. 

Figure 4-2 InCyte™ application window – Analysis screen

The Analyse control panel provides a working outline for each analysis session. It 
contains three panes—the Data, Analysis Methods, and Analysed Data. An FCS file 
generated using InCyte™ will automatically contain all three elements.
• The Data pane lists all open FCS files, as well as any groups (FCS file subsets) 

created. For more information on groups, see “Creating a Group” on page 4-46.
• The Analysis Methods pane contains all Method(s), each comprised of its associated 

plots, regions, gates, and metrics. Methods can be thought of as analysis strategies. 
• The Analysed Data pane lists all user-defined AnalysedGroups. Analysed Groups are 

created by pairing the data file with Method—each consisting of a data file (or group) 
with its associated Method. When you close an Analysed Group, the associated FCS 
file and Method will close automatically.

Place your cursor over an icon in any of the three panes to see text describing the icon 
. For more information on the control analysis panels, see “Analyse 

Control Panel” on page 1-19.

Analysis control panel:
• Data pane
• Analysis Methods pan
• Analysed Data pane

Plate map

Tool bar
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Analyzing Files Acquired Using InCyte™

Data files acquired using InCyte™ will already have the necessary components for each 
of the three Analysis panes—the data file, the Method, and the Analysed Group. Simply 
open the FCS file.
During analysis, the original FCS file and any analysis settings (plots, parameters, gates) 
will not be affected. If you wish to save any changes to the newly analyzed InCyte™ file, 
simply resave the file using the Analysed Data pane (Save Analysed Group button). 
You can proceed to analysis from the acquisition screen.

 NOTE: You can analyze tube-based data but the results cannot be displayed in the 
plate map. Additionally, the gates and markers do not carry over from one tube to the 
next. Tubes must be analyzed individually (tube-by-tube basis). Use the Stat Setup 
feature to obtain results for tube data. 

 NOTE: If you open and analyze multiple files within a session, all the FCS data files, 
Methods, and Analysed Groups will remain in the panes from all file that were 
opened. If they have already been saved, you can remove them from the pane by 
selecting the item and clicking the Delete icon at the bottom of that pane.

1 From the Analyse screen, choose File > Open from the menu bar. Select an FCS file 
for analysis and click Open. You can also use the Open Group icon in the Data pane 
or the Open Analysed Group icon in the Analysed Data pane. You can also drag and 
drop an FCS file from a folder to the Data pane. 

The data for the first sample appears. For information on selecting the number and 
type of plots (dot plot, histogram, or contour plot) you wish to display, and changing 
the plot parameters, see “Plots” on page 4-2.
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Click the + to the left of the data file name to display a list of all samples contained in 
the file. All wells with acquired data appear as open circles in the corresponding 
locations in the plate map. 

Clicking on a sample in the Data pane will display the unanalyzed data for that sample 
in the plots, however the information in the plate map will be lost. Click on the 
Analysed Group to redisplay the information in the plate map. If the data is already 
analyzed, click on the individual wells in the plate map to display the analyzed data for 
that well in the plots, or use the arrow keys to quickly scroll through the wells, 
displaying the data.

NOTE: An icon appears in the upper-left corner of the plate map. It allows you to toggle 
between the tube map and plate map. Samples from tubes acquired on your 
easyCyte™ System will always appear in the plate map. If the data set was acquired on 
an easyCyte™ HT System, which allows you to acquire from both tubes and a 
microplate, the samples acquired from tubes will show up in the tube map.  

 NOTE: If you wish to create groups of samples for analysis, see “Creating a Group” on 
page 4-46.

2 You are now ready to start customizing your Analysis Method using regions and 
gates. See “Regions, Gates, and Statistics” on page 4-19.

If applicable, click icon to toggle 
between plate map and tube map.
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Analyzing Files Acquire Using Other guava® Software Modules

Data acquired using any guavaSoft™ module other than InCyte™, for example, 
ExpressPro, will not have an Analysis Method associated with it. However, when you 
open the file in InCyte™, a default Method will automatically be created.

1 From the analysis pane, choose File > Open from the menu bar. Select an FCS file 
for analysis and click Open. You can also use the Open Group icon in the Data pane 
or the Open Analysed Group icon in the Analysed Data pane. You can also drag and 
drop an FCS file from a folder to the Data pane. 

The data for the first sample well appears. For information on selecting the number 
and type of plots (dot plot, histogram, or contour plot) you wish to display, and 
changing the plot parameters, see “Plots” on page 4-2.
Click the + to the left of the data file name to display a list of all sample wells and 
tubes contained in the file. All wells with acquired data appear as open circles in the 
corresponding locations in the plate map. Data for any well can be displayed in the 
plots by selecting the sample from the file list or clicking on a well in the plate map. 
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2 When a data file is generated in a guava® software module other than InCyte™, 
InCyte™ will automatically create a default Analysis Method and Analysed Group for 
the data file/set. The Method will contain a percent (%) metric, initially. If you wish to 
open an existing Method use the Open Method icon. Method files have the extension 
.gsy. To rename the Method, double-click it and enter a new name related to this 
analysis. 

3 If you opened an existing Method, you will need to drag it to the Analysed Group. 

Notice the sample wells in the plate map become dark blue (if the Method was newly 
created) or various shades of blue (if a previously defined Method is used). You can 
place the cursor over any well in the plate map to view results for that sample. 
Clicking on a sample in the Data pane will display the unanalyzed data for that sample 
in the plots, however the information in the plate map will be lost. Click on the 
Analysed Group to redisplay the information in the plate map. Click on the individual 

Click New Method to create a new Method.

Analysis Method containing a metric, gate list, and 
region list.

Data and Method are 
automatically paired 
to create an Analysed 
Group. If you open a 
saved Method, you 
will need to drag it to 
the Analysed Group.
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wells in the plate map to display the analyzed data for that well in the plots, or use the 
arrow keys to quickly scroll through the wells, displaying the data.

 NOTE: Any data file or Method file can be replaced by simply selecting it from the 
respective pane and dragging to the Analyzed Group. This allows you to quickly 
interchange data files and Methods. 

To save an AnalysedGroup, click on it in the Analysed Data pane to select it, then 
click the Save Analysed Group icon. Navigate to the location, enter a name, and click 
Save. The AnalysedGroup will be saved as an FCS file and will contain the method 
(regions, gates, metrics, and stats), as well as the data and the instrument settings. 

4 You are now ready to start customizing your Analysis Method using regions and 
gates. Refer to “Regions, Gates, and Statistics” on page 4-19. 

Regions, Gates, and Statistics

Regions
InCyte™ offers six types of regions/markers—ellipses, rectangles, octagons, polygons, 
and quadrant markers for dot plots, and histogram markers for histograms. All of these 
regions are created using either the New Region icon in the plot tool bar (see “Plots” on 
page 4-2), except the quadrant marker, or the New Stat Marker icon in the tool bar, which 
allows you to select statistics for the region/marker. For information on creating 
quadrants, refer to “Stat Markers” on page 4-26. A single Analysis Method can contain a 
maximum of 24 regions or stat markers, and you can have multiple stats per marker.
InCyte™ regions are associated with the one (histogram) or two (dot plot) parameters in 
which they were created. If you change the x- or y-axis parameter on the plot, the region 
is no longer displayed. However, it is still contained within the Method. 

1 Once an AnalysedGroup is created, either by pairing a data file with a Method or 
dragging the AnalysedGroup to the legend, click the New region icon in the plot tool 
bar and select a region from the pop-up menu. 
You are prompted to enter a region name. The default is R1. When creating a 
polygon, this dialog appears after you create the region.  

AnalysedGroup containing a data file and Analysis Method.
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2 Enter a name for the region and click OK. 
You may leave it R1, but a unique region name can be helpful in differentiating 
Analysis Methods.
The newly created region appears on the plot with the region name. Click and drag 
the name to move it. The region is listed in the Region List under the Method (see 
below) and in the Region List table (Region List icon in the main tool bar or Tools > 
Show Region List). To delete a region, see “Region List” on page 4-21. 

3 Adjust the region to encompass the data. Or, for a polygon, create the region.
• To adjust an elliptic region, click anywhere on the edge 

of the ellipse, except on a handle, and drag it to a new 
location. The ellipse has two handles. The open circle 
allows you to narrow/widen the ellipse. The solid circle 
allows you to lengthen, as well as rotate the ellipse 
around a point opposite the solid circle. 

• To adjust a rectangle region, click anywhere on the 
edge of the rectangle, except on a handle, and drag it to 
a new location. The rectangle has five handles. The 
open squares allow you to extend at the corresponding 
corner. The solid square allows you to rotate and resize.

• To adjust an octagonal region, click anywhere on the 
edge of the octagon, except on a handle, and drag it to 
a new location. The octagon has eight handles. Click 
and drag the handles to adjust the shape of the 
octagon. To add or remove segments, right-click on a 
handle and select Insert Line Segment or Delete Line 
Segment. 

• To create a polygon region, click to add the first 
handle, then move the cursor to the next point and click. 
Continue creating up to 32 segments until the shape is 
complete. Finish by clicking again at the first handle to 
close it. To move it, click anywhere on the edge, except 
on a handle, and drag it to a new location. To adjust the 
shape, click and drag the handles. To resize or rotate, 
press the Shift key and click and drag a handle. 
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• To adjust a histogram region, click either of the two 
handles. The histogram marker can be moved vertically 
as well as horizontally. 

Region List

When you create a region, it appears in the Region List. To 
display the list, click the Region List icon in the tool bar or choose Tools > Show 
Region List. The Region List displays a list of all regions and quad stat markers (see 
page 4-26) in the selected Analysis Method, their type, and plots axes. 

• To display all the columns in the Region List window, click Resize. 
• To delete a region from the plot, click to select it, then right-click and select Delete 

Region. You can also select the region in the Region List window and click Delete. 
Click OK in the confirmation box. The region will be deleted from all associated 
plots. The region name in the Analysis Method will appear as ???.

Global and Local Region Adjustments

You can make adjustments to regions for specific samples within a data set. For example, 
you may wish to tweak a region for the data in one or more samples to compensate for a 
shift in the data.

1 To change a region for an individual sample, press and hold the Ctrl key while 
manipulating the region (elliptic, rectangle, octagon, or histogram). 
To change the region for multiple samples, highlight the desired wells, then hold the 
Ctrl key while manipulating the region. The change will be applied to all the 
highlighted samples.

The region will turn from red to black, indicating that it is a local region—it applies only 
to the sample data displayed in the plots. 

 NOTE: If you manipulate a global region without holding down the Ctrl key, the 
change will automatically apply globally (to the data for all samples in the run).

Once a local region is created: 
• if you have only one local region in the data set and you attempt to manipulate it 

without holding down the Ctrl key, the change will become global and apply to all 
regions in the data set.
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• if you have multiple local regions and you attempt to manipulate a single local or 
global region without holding down the Ctrl key, the following message appears:

• To apply the change to the region you are adjusting and all global regions, but 
keep any other local regions unchanged, click Keep Local. 

• To apply the change to all samples in the run, click Make Global.
• To cancel the change and not apply it to any regions, click Cancel.

If you want to make an adjustment to a local region to manipulate it further, hold down 
the Ctrl key to keep the change local and not affect any other regions—local or global.

After making a region(s) local, you can still make adjustments to global regions 
without holding down the Ctrl key. When the dialog box appears, click Keep Local. 
The adjustment will apply to all global regions. The local regions will remain local and 
unchanged. 

Gates
A gate can be as simple as a single region, or a complex combination of regions and 
multiple parameters. Gates allow you to further characterize and isolate populations 
based on the regions. A maximum of 32 gates can be created for one Analysis Method. 
You can create gates for analysis and/or acquisition. Count gates used during acquisition 
allow you to acquire specific populations of interest. All events above the threshold are 
saved to the file whether they are in the gate or not. However, the number of Events to 
Acquire is applied to events that fall within the gate. 

Defining a Gate

The gating process has been simplified by dragging and dropping regions. Any region 
can be dragged from one plot to any other plot. This process allows you to create gates 
defined with the “AND” operator. You can also create gates using the OR and NOT 
operators. Refer to “Gate List” on page 4-24.

1 Click to select the region (handles appear), then click in the center of a region and 
drag it to another plot. 
This “applies” the data within the boundaries of the region to the second plot. For 
example, if you created a region on live cells in plot 1 and drag the live-cell region to 
plot 2, only the live cells will be displayed in plot 2. A New Gate Name dialog box 
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prompts you to rename the newly created gate. You can enter a more meaningful 
name or use the default. 

 NOTE: You can also define a gate by typing the regions and the operators AND, 
OR, and NOT. Refer to “Gate List” on page 4-24.

If the Analysis Method has gates already defined, you can also select a gate from the 
Plot gate menu in the plot tool bar. 

When you apply a gate, the following changes occur:
• The events displayed in Plot 2 will automatically change to reflect only those 

defined by the region that was dragged in. To view the ungated data again, click 
the Plot gate icon to the right of the plot and select <ungated>.

• The color of the newly gated data will reflect the color of the gate defined in the 
Gate List window. The default color for the first gate is red.

• The plot heading will reflect the gate applied (for example, Plot P01, gated on 
P02.R1).

• The newly created gate will appear in the Analysis Methods pane under the 
Method, in the Gate List (see "Gate List" below), and the Plot gate pop-up menu to 
the right of the plot. 

 NOTE: Changes made to the position or size of any region(s) used to define a gate 
will automatically be reflected in all plots gated by that region.

Select the region, then drag it from one 
plot to another to apply a gate.
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Gate List

When you create a gate, it appears in the Gate List. To display the list, click the Gate List 
icon in the tool bar or choose Tools > Show Gate List. The Gate List displays a list of all 
gates in the selected Analysis Method, their definition, and color. 

• To display all the columns in the window, click Resize. 
• To delete a gate from the list, select the gate and click Delete. Click OK in the 

confirmation box.
• To change the gate color, double-click the color in the Color column. The 

ColorPickerDialog appears. See “Changing the Color of Gated Data” on page 4-25 
for information on using this dialog box to change the color. 

• You can turn a region into a gate by entering a name for the gate in the Name field 
and typing the region name (for example, R1) in the Definition field.

• You can also define a gate using the operators AND, OR, and NOT. Create regions 
to identify the subpopulations of interest. Open the gate list and type an 
appropriate name for the gate. Type a definition, for example:
– R1 AND R2 means the event must be in both the R1 and R2 regions to be 

included in the gate.
– R1 OR R2 means the event must be in either the R1 or R2 region to be included 

in the gate.
– R1 AND (NOT R2) can be used if R1 and R2 overlap and you want to include 

events in R1 but not in R2. 
The gate can now be applied to any plot by clicking the Plot gate icon to the plot 
tool bar and selecting the gate from the list. 

• The ColorGate box allows you to view a backgate. Create a gate in one plot, then 
drag that gate to the plot of interest. This applies the gate to the second plot and 
shows only the gated events. Select Tools > Show Gate List and check the 
ColorGate box for the gate. The gated events appear in both plots in the selected 
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color. View the second plot without a gate (select <ungated> from the plot tool bar) 
to see the color gated events in relationship to all events. 

Changing the Color of Gated Data

You can change the color of data within a gate. 
Open the Gate List and double-click the color in 
the Color column to open the ColorPickerDialog. 
Use this dialog to change the color, hue, 
saturation, and brightness. 

1 To change the color, click the RGB button and 
use the sliders to adjust each color. Or, click to 
select a color in the outer circle. Drag the 
pointer to change the color.

2 To adjust the hue, saturation, or brightness, 
click the HSB button and use the sliders to 
make the appropriate adjustments. Or, click a 
shade in the inner triangle. 

3 Click OK when you are finished. 

A lymphocyte gate was created in the RED (CD3 PE-Cy5.5) vs SSC plot, then dragged to the YEL (CD14 PE) 
vs GRN (CD15 FITC) plot. Granulocyte and monocyte gates were created in the YEL vs GRN plot and 
dragged to the RED vs SSC plot. ColorGate checkboxes were selected for all gates to apply color to the 
gated events. All plots are viewed ungated to show all data and gated data in colors.
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Stat Markers

The Stats feature allows you to derive, display, and export statistics for single samples, 
groups, or whole data sets. Each stat is derived from a region/marker. Stats can be 
assigned to existing regions, or new regions can be created. A single Analysis Method 
can contain a maximum of 24 regions/markers. 

1 Click the New Stat Marker icon in the plot tool bar and select the appropriate option.
You can obtain statistics for any existing regions in the plot. Or, you can create a new 
region and obtain statistics for that region. 
• Select New Elliptic/Rectangle/Octagonal/Quad/Histogram Stat Marker to add a 

new region and obtain stats for it. Histogram Stats appear only in a histogram plot.
• Select New Stat for R1 (or name of existing region) to obtain stats for an existing 

region. 
• Select New Expression Stat to create an expression statistic. See “Creating 

Expression Statistics” on page 4-29.
• Select Show Stat Setup to display the Current Run Stats. See "Current Run Stats 

Window" in the following section.
• Select Edit Plot Corner Labels to add custom labels to your plots. See “Labeling 

Plot Corners” on page 4-31.  

The Add New Stat Marker window appears for the stat type you selected. The default 
base stat name is the same as the gate name. Base stat implies it is the base name 
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before you selected a specific metric (stat), then the stat name becomes 
BaseStatName.Metric.  

2 Select the metric—Percent, Count, Mean, and Median, Concentration, or %CV.

3 For quad stats only, select the quad region(s) of interest. Select Show on plot if you 
wish to see the stat for each quadrant appear in the corners of the plot. If multiple 
parameters are selected, the count appears by default.
Quadrant markers will appear on the plot after you click OK.

4 Click OK. 
The Current Run Stats window (see below) appears with the newly created stat. The 
value listed corresponds to the sample well highlighted in the plate map. Each stat is 
automatically applied to all samples in a given data set. To see the results for any well, 
click on the well in the plate map. If you adjust the marker/region or any region that is 
part of the gating strategy, the statistics are automatically updated. 

To adjust quadrant markers, click to select the markers. 
The handles will appear solid. Position the cursor over 
the handle at the intersection and drag to the desired 
location. You can adjust the angle of the markers ±44° 
from their original locations. Drag the handle (solid 
circle) towards the end of the marker and tilt it to the 
desired location. 

If a stat with the default name already exists, the field 
will appear red. You must enter a new stat name.
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Current Run Stats Window

The Current Run Stats window appears when you create a stat. You can also click the 
Show Current Run Stats icon in the main tool bar or select Tools > Show Current Run 
Stats from the menu bar to display the window. For each Analysis Method, all stats for all 
plots are listed in this window. The Values displayed correspond to the sample well 
highlighted in the plate map. Simply click any well to see the value for that sample. Stats 
are listed in the order they were created. To reorder them in the list, see “Current Run 
Stats Setup Window” on page 4-28. 
For each Analysis Method, all stat markers are listed in the Region List, as well as the 
Analysis Methods pane. All stats are saved with the Method. 

• Click Setup to customize the stats listed in the Current Run Stats window.
• Click Print Stats to print the statistics listed in the table.
• To copy the window to the clipboard right-click in the window and select Copy to 

Clipboard.

Current Run Stats Setup Window

To customize the statistics that are listed in the Current Run Stats window, click Setup. 
The Current Run Stats Setup window appears. 

customize stats

Click to remove a column from the 
Current Run Stats window.

Click the box to the far left and 
drag the row up or down in the list.
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• To change the Stat Name, double-click the name and enter a new name. To change 
the metric, gate, quadrant, marker name, or parameter, double-click the item and 
select the new one from the drop-down list. Expression stats cannot be modified. They 
can only be deleted.

 NOTE: If you wish to change the parameter, double-click to display the parameters 
for that plot. If you wish to see all available parameters for the data set, press Ctrl 
and double-click the parameter value. For a parameter to be displayed, you must 
select it in the Add New Stat Marker dialog.

• To remove a column, remove the “Show” check mark for the selected parameter(s) 
and click Done. The Current Run Stats window is updated.

• You can also create stats directly from the Current Run Stats Setup window. Click Add 
New Stat to display the Add New Stat Marker window. This window is similar to the 
window that appears when you select Show Stat Setup from the New Stat Marker 
icon in the plot tool bar (see page 4-26). However, this stat marker window allows you 
to create a stat independent of a plot and based on any gate. Enter a stat name, then 
select the marker/region, gate, parameter, and metric, and click OK. 

• To reorder the rows and/or columns in the Current Run Stats Setup window, click the 
far-left box of the row and drag the row up or down, or click the column header and 
dragg the column to the left or right. You cannot move the Stat Name or Value column. 
They are fixed.

• To delete a stat, select the stat from the list and click Delete. 

Creating Expression Statistics

Expression stats allow you to create custom statistics. For example, you can apply the 
dilution factor to a count or concentration value of a specific population to get the actual 
value for your diluted sample. Or, you can create an expression statistic that adds the 
events in two quadrants of quad markers. 

1 Create statistics as you normally would.

2 Click the New Stat Marker icon in the plot tool bar and select New Expression Stat. 

3 Enter a stat name for the expression.
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4 Right-click in the Expression area of the window and select the stat. Type an operator 
(+, –, *, /, or ^ for exponentiation). Complete the expression. 

 NOTE: To create an expression for a specific tube, press Ctrl and right-click the 
Expression area. The pop-up menu allows you to select a specific tube.

The following example shows an expression created to apply the dilution factor of 20 
to events in the upper-left quadrant of a plot. 

5 Click OK.
The expression appears in the Current Run Stats window. 

6 Click the Show Sample Info icon in the tool bar to the left of the data panes to open 
the sample information window. Enter the dilution factor for the sample and press 
Enter. 

Right-click and select the statistic to build the expression. 
Enter the appropriate operator, and continue building 
expression.
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7 The updated concentration value, based on the new dilution factor, appears in the 
Current Run Stats window. 

Labeling Plot Corners

You can add custom labels to the corners of any plots. Default labels already appear in 
plots with quadrant markers, if you select Show on plot when setting up the quadrant 
using the New Quad Stat Marker option. 

1 Click the New Stat Marker icon in the plot tool bar and select Edit Plot Corner 
Labels.

The Edit Plot Corner Labels dialog appears. 

2 If you are adding labels to a plot with quadrant markers, click the default [count] label 
and type a new label. If you are adding labels to a plot without quadrant markers, 
simply type the label in the corresponding box.

3 Click OK. The labels appear in the corners of the plot.

Labels for quadrants.
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Group Stats Window

The Group Stats window displays the statistical values for all samples in the data set (or 
group). To display the Group Stats window, click the Show Group Stats icon in the main 
tool bar or select Tools > Show Group Stats from the menu bar. 

• Click Setup to customize the stats listed in the Group Stats window.
• Click Export To CSV to export the group stats to a comma-separated values file for 

analysis using a spreadsheet program. Select the location, enter a file name, and click 
Save.

• Click Print Stats to print the statistics listed in the table.
• To copy the window to the clipboard, right-click in the window and select Copy to 

Clipboard.

Group Stats Setup Window

To customize the statistics that are listed in the Group Stats window, click Setup. The 
Group Stats Setup window appears. To remove a column, remove the “Show” check mark 
for the selected parameter(s) and click Done. The Group Stats window is updated.
You can reorder the rows by clicking the far-left box of the row and dragging the row up or 
down. 

To reorder the rows, click the box 
to the far left of the row and drag 
the row up or down in the list. 
4 - 32 guava easyCyte™ System User Guide



Exporting Results

Exporting guava InCyte™ Results to a Spreadsheet File

For each AnalysedGroup, you can export the results to a comma-separated values (CSV) 
file for analysis using a spreadsheet program such as Microsoft Excel. The CSV file will 
contain the following statistics: Group name, Stat Type, Parameter, Stat gate, Control 
gate, Log Display, Max, Threshold Max%, Threshold Max, Threshold Min%, Threshold 
Min. In addition, each sample well will include a derived statistical value, its unit of 
measurement, a control well (if applicable), the well's sample ID, and the FCS 3.0 file 
from which it was derived. 

1 Right-click on any well and select Export Heatmap Stats to CSV.
If the HeatMap legend is divided into multiple sectors, then data from each sector will 
be exported. If you wish to export results for a single sector (or AnalysedGroup), first 
click on the specific sector in the legend, then right-click the well and select Export 
Heatmap Stats to CSV.
To export the group stats to a CSV file, refer to “Group Stats Window” on page 4-32. 

 NOTE: You can copy and save any of the plots, HeatMap, or IC-50 graphs by right-
clicking, then selecting Copy To Clipboard.

Exporting guava InCyte™ Results to FCS and List-Mode Files

You can export guava InCyte™ results from the current run or any sample run to both 
FCS 2.0 and FCS 3.0 files. The data must have an AnalysedGroup associated with it. 
One FCS file is saved for each sample acquired. You can analyze both FCS 2.0 and 3.0 
files using a third-party flow cytometry analysis application. FCS 3.0 files are exported 
with all parameters included. FCS 3.0 files with semi-automated or post-acquisition 
compensation may be compatible with some third-party applications. For more 
information, contact EMD Millipore Technical Support. You can also export list-mode data 
files.

1 To export analysis results for all sample data within the run to individual FCS 2.0 or 
3.0 files, select File > Export to FCS 2.0, Export to FCS 3.0, or Export List Mode 
Data.
You can also select a specific AnalysedGroup from the Analysed Data Pane and 
select the appropriate export option from the File menu. 

2 Select the folder where you want to save the file, and enter a file name. Click Save.
The samples are numbered sequentially and a number is automatically appended to 
the file name. For example, if the sample number is A01, the file will be named 
filename-1.FCS, A02 is filename-2.FCS, etc. 
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Compensation
This section provides details on specific compensation adjustments for your stained 
samples during acquisition. It also includes information on performing post-acquisition 
compensation and automated compensation on data files acquired with ExpressPlus, 
ExpressPRo, and InCyte™ only.

Performing Manual Compensation
You can perform compensation before or after acquiring your samples. Use the 
Compensation Controls to select the radio button for the signal you wish to subtract, then 
use the slider to adjust how much of that signal to remove from the detector/channel.
Click the Show Compensation Controls icon in the tool bar to open the Compensation 
Controls window.

 NOTE: The controls at the far left are for semi-automated compensation only.   

You must check the compensation for each fluorochrome combination you are using. 
Compensation settings are correct when the center of the stained population is aligned 
with the center of the isotype or negative control population. Avoid having too many cells 
touching the axis (overcompensated).

 NOTE: Some fluorochromes require very little compensation because they have little 
overlap, such as PE into the GRN channel (GRN-B – % YEL-B), as shown in the first 
three plots below; whereas others require much more compensation because they 
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have more overlap, such as FITC into the YEL channel (YEL-B – % GRN-B), as 
shown in the last three plots below. 

During Acquisition

1 Select the radio button for the signal you wish to subtract, then use the slider to adjust 
the percentage of the signal you wish to subtract from the detector. 
For example, to remove the FITC signal from the YEL detector, select the –% GRN-B 
radio button under Dye. Then adjust the YEL slider to remove the FITC signal from 
the YEL channel (YEL-B – % GRN-B). Next, using the PE single-color control, select 
the –% YEL-B button, and adjust the GRN-B slider to remove the PE signal from the 
GRN channel (GRN-B – % YEL-B).

Post-Acquisition Compensation

InCyte™ allows you to perform post-acquisition compensation on data files acquired using 
software modules that have the compensation feature and allow you to adjust 
compensation during acquisition, such as ExpressPlus, ExpressPro, and InCyte™. 

 NOTE: You can adjust compensation only; you cannot adjust gain settings.

GRN–%YEL– FITC Single-color stained cells
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1 Open the FCS file from the Analyse control panel and set up the plots.
We recommend using single-color samples, then checking the compensation again 
with a sample stained with all fluorochromes to fine-tune, if necessary.

2 Select the radio button for the signal you wish to subtract, then use the slider to adjust 
the percentage of the signal you wish to subtract from the detector. 
For example, to remove the FITC signal from the YEL detector, select the – % GRN-B 
radio button under Dye. Then adjust the YEL slider to remove the FITC signal from 
the YEL channel (YEL-B – % GRN-B). Next, using the PE single-color control, select 
the  –% YEL-B button, and adjust the GRN-B slider to remove the PE signal from the 
GRN channel (GRN-B – % YEL-B).

3 Repeat for the remaining compensation adjustments for your samples.

 NOTE: The controls at the left of the window are for semi-automated compensation 
only.   

Settings are applied to all samples in the data set, as well as all groups derived from 
the data set. Adjustments made to a sample within a group, are applied to all samples 
in the originating data file. 

Performing Semi-automated Compensation
InCyte™ allows you to perform semi-automated compensation on data files acquired using 
software modules that have the compensation feature and allow you to adjust compensation 
during acquisition, such as ExpressPlus, ExpressPro, and InCyte™. You must have 
acquired single-color control samples to use the semi-automated compensation feature.

 NOTE: You can adjust compensation only; you cannot adjust gain settings.

1 To adjust compensation, open the FCS file from the Analyse control panel and set up 
the plots.
W recommend using single-color samples, then checking the compensation again 
with a sample stained with all fluorochromes to fine-tune, if necessary.

2 Click the Show Compensation Controls icon in the main tool bar to open the 
Compensation Controls window.
This window is specific for compensation during analysis. It contains a slider for each 
parameter and a list of controls in the far left panel. These controls correspond to 
each parameter and the fluorochrome used: 
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 NOTE: If it is necessary to gate the data, pair a Method with the data file to create an 
Analysed Group and set regions and gates. Refer to “Gates” on page 4-22. 
Otherwise, it is not necessary to create an Analysed Group to adjust post-acquisition 
compensation. 

3 Click Setup in the Compensation Controls window. 
The application screen changes to display two dot plots on the left with the plate map 
below, and up to six histograms for each fluorescence channel. 

4 Adjust the default region in plot 1 so that it encompasses the events of interest. 

5 Drag the isotype (or negative) control from the plate map to the black square at the far 
left in Compensation Controls window

6 Drag the next control, for example the GRN control (FITC-positive control) from the 
plate map to the green square at the far left in the Compensation Controls window 
(see example in figure below). 

Comp Color Channel Laser

BLU-V

405 nm (Violet)
GRN-V

YEL-V

RED-V

GRN-B

488 nm (Blue)
YEL-B

RED-B

NIR-B

RED-R
642 nm (Red)

NIR-R

negative or isotype control
Compensation 4 - 37



For this example, the green square turns into a circle and the FITC control data is 
displayed in the GRN histogram.

7 Adjust the GRN histogram marker to include the positive population. 

8 Drag the next control, for example YEL control (PE-positive control) to the yellow 
square. Continue dragging the remaining controls to the corresponding Controls 
squares and adjusting the markers to include the positive population.

9 Check that the markers are correct for the isotype control.

10 Click Auto. The software automatically calculates the compensation values for each 
parameter.
Settings are applied to all samples in the data set, as well as all groups derived from 
the data set. Adjustments made to a sample within a group are applied to all samples 
in the originating data file.

11 If you need to adjust compensation further, refer to “Post-Acquisition Compensation” 
on page 4-35.

12 Click Finish to return to the analysis display.

HeatMap
HeatMapping provides a colorimetric representation of comparative results at the 
experiment level. Each Analysed Group is represented by an individual sector in the 
HeatMap legend. After the completion of sample analysis, individual parameters can be 
compared over the entire experimental run. A visual representation of the data and the 
results will appear in the plate map. Well-to-well variations in blue (dark blue = maximum 

Drag
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value, white = minimum value) are based on relative differences in the data as measured 
on a linear scale. 
The plate map can simultaneously display results for up to six Analysed Groups—the 
same number of sectors that the legend is displaying. Place the cursor over any well to 
see the result for that Analysed Group. When the HeatMap legend displays more than 
one sector, the results for every sector will appear within the well pop-up.

 NOTE: If the Analysis Method used to create the Analysed Group is new (no regions 
and/or gates have been defined), the plate map will initially display all wells as dark 
blue. Perform the analysis on the data before proceeding to HeatMapping. 

Creating a HeatMap
The following examples show how to use the HeatMap to get a visual and numerical 
representation of results for a single or multiple parameters from one data file. This 
example shows a sample stained to detect mitochondrial membrane potential, cells 
undergoing apoptosis, and dead cells.

Single-Parameter HeatMap Using a Region or Gate

1 Open the Analysed Group.

One sector in HeatMap Legend Six sectors in HeatMap Legend
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You can also open an FCS data file and perform the analysis for the populations you 
are interested in. See “guava InCyte™ Analysis” on page 4-13, for information. 

2 Select the gate of interest, then click and drag it to the Analysed Group in the 
Analysed Data pane. Click OK to accept the new gate name, or change the name.

As you start to drag the gate, a gray box appears at the cursor. Drag the gate to the 
Analysed Group and a plus sign (+) appears on the cursor. Drop the gate in the 
Analysed Group.

 NOTE: You can also use the HeatMap legend by dragging the Analysed Group and 
the gate to the legend. Then, to update the analysis, simply drag a new gate to the 
legend. The plate map will update automatically.

Jurkat cells were stained with FlowCellect MitoDamage kit to look at mitochondria membrane potential 
(MitoSense Red), apoptosis (Annexin V CF488), and cell death (7-AAD). R1 was created for cell 
population, then applied to plots 2-4. Three regions were created for each population of interest.
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After the gate is applied to the Analysed Group, the wells will change to varying 
shades of blue, depending on the population percentages. Place the cursor over any 
well to see value for that well. 

3 To change the metric and/or threshold, see “Metrics” on page 4-43 and “Thresholds” 
on page 4-43.

4 To save the HeatMapped Analysed Group, select it and click the Save button (3rd) in 
the pane. Navigate to the location where you wish to save it, enter a file name, and 
click Save. The Analysed Group will be saved as an FCS file and will contain the 
Method (regions, gates, metrics, and stats), as well as the data and the instrument 
settings. 

Multi-Parameter HeatMap Using a Region or Gate

The following example is the same as the single-parameter HeatMap shown above. In 
this example, three Analysed Groups are created to view and compare the results for 
three different populations simultaneously. 

1 Open the Analysed Group.

2 To compare multiple parameters from one FCS file, duplicate the Analysed Group. 
Select the Analysed Group, then click the Duplicate button (4th button) in the pane.

For this example, the Analysed Group was duplicated twice to obtain results on three 
populations.

3 Select the first Analysed Group, then click to select and drag the gate of interest to 
this Analysed Group. Click OK to accept the new gate name, or change the name.

MitoSense Red region is dragged to the Analysed Group. Plate map displays well-to-well variation of 
relative percentage of mitochondrial membrane potential among samples.

Drag gate
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4 Select the second Analysed Group, then click to select and drag the next gate of 
interest to this Analysed Group.

5 Repeat by dragging the remaining gates to the Analysed Groups.

6 (Optional) To change the name of an Analysed Group, double-click it and type the 
new name.

7 Click the Pie Legend icon in the tool bar on the left side of the application window to 
display the HeatMap legend. Select the number of sectors (N) to display. 

8 Click and drag the Analysed Groups to the appropriate sectors. Then, click the center 
circle in the legend to display the results for all populations of interest in the plate 
map.

 NOTE: When multiple sectors are displayed, no data is shown in the plots and you 
cannot modify any Methods (add regions, move gates, etc). To modify individual 
Methods, click on the sector you wish to update.

For more information on the HeatMap legend, see “Pie Legend” on page 4-5. 

9 The plate map shows each well with the number of sectors used for analysis. Place 
the cursor over any well to see all the values for that well.

10 (Optional) To clear a sector, right-click on the sector in the HeatMap legend and select 
Clear sector.

11 To change the metric and/or threshold, see "Metrics" and “Thresholds” on page 4-43.

12 To save the HeatMapped Analysed Groups, select one and click the Save button (3rd) 
in the pane. Navigate to the location where you wish to save it, enter a file name, and 
click Save. The Analysed Group will be saved as an FCS file and will contain the 
Method (regions, gates, metrics, and stats), as well as the data and the instrument 
settings. Repeat for the remaining groups.
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Single-Parameter HeatMap Using a Statistic or Expression Stat

The following example shows how to use the HeatMap to get a visual and numerical 
representation of results for a single or multiple parameters from one data file. 

1 Open the Analyzed Group.

2 If necessary, create a stat region or a statistic for any region created. For more 
information on creating statistic gates and statistics for regions see “guava InCyte™ 
Analysis” on page 4-13.

3 Click the Pie Legend icon in the tool bar on the left side of the application window to 
display the HeatMap legend. 

4 Select the statistic of interest, then click and drag it to the Analyzed Group in the 
Analyzed Data pane. Click OK to accept the new gate name, or change the name.

Thresholds

The Workspace contains a dual-barred threshold tool for setting upper and lower limits on 
statistical values. The threshold bars can be used to set limits on a single AnalysedGroup 
at a time (the one that is displayed in the plate map). If the HeatMap is displaying multiple 
sectors, the threshold feature is disabled.
Above the threshold panel is the maximum derived value for a 
given data set. Each slider tool is based upon a % scale where the 
minimum value (0 is lower limit) is Zero and the maximum value 
(100 in upper limit) is defined by the maximum value derived from 
the analysis. Simply slide the bars up or down to set boundaries for 
data display. 
In addition, any well can be selected to represent the MAX value. 
To set a MAX, right-click on a well and select Use as Max from the 
menu. The new max value will also be displayed at the top of the 
threshold panel. 

Metrics
Metrics are the statistical parameters applied to a set of gated events. Applying a metric 
results in the calculation of a numerical value for each well/sample. These values are 
compared across a given data set and determine the well-to-well variability in color 
displayed in the plate map. There are six metrics from which to choose:
• Percent (%) - Percentage of events within a given gate relative to the total number of 

events displayed within the originating plot.
• Count - Number of events within a given gate.
• Concentration - Event count for a gate as a function of the volume of sample acquired 

(events/uL).
• Mean - Mean fluorescent intensity (MFI) for a set of gated events. If derived from a dot 

plot, the mean value applies to the parameter associated with the x axis. (For log 
scale, the mean is geometric; for linear scale, the mean is arithmetic.)

max 
value
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• Median - Median fluorescence for a set of gated events. If derived from a dot plot, the 
median value applies to the parameter associated with the x axis.

• Mean Ratio - A measure of the fluorescence intensity for a set of gated events as 
defined by the following: ratio = MFIwell X/MFIcontrol well. The control MFI may be 
derived from a single sample or represent the average value from a set of control 
samples. To apply a mean ratio, select Mean Ratio. Using the plate map, select the 
appropriate control well(s) and drag to the corresponding legend sector. This well’s 
value is used as the denominator in the above equation. You must select a control well 
as the denominator to get a mean ratio.

Changing the Metric

The default metric for a new Method is percent. To select a different metric, double-click 
the metric in the Analysis Methods pane, then open the drop-down list to display the 
Metric list. Select a metric to apply it as the statistical parameter for that Method. Once 
selected, the newly chosen metric will replace the previous one. If you are heatmapping 
and the corresponding Method occupies a legend sector, the plate map will automatically 
update to reflect the change.  

IC-50/EC-50
Understanding the kinetic characteristics of a given compound's mode of action is 
important for determining efficacy, toxicity, and dosage. Assays measuring parameters 
such as apoptotic status or protein expression are commonly used to obtain this 
information. Use the IC-50 application to create curves based on the relationship between 
concentration and response, where response is measured by changes in the statistical 
parameter for the applied Analysis Method. IC-50 (or EC-50) values are derived directly 
from the calculated curves. 
• The EC50 value is the concentration of a drug, antibody, or toxicant which induces a 

response halfway between the baseline and maximum following a specified exposure 
time. 

• The IC50 is a measure of the effectiveness of a compound to inhibit or reduce a 
measurable response by 50% relative to the baseline (which in this case is a 
maximum value) and absolute minima.

To change the metric, double-click the metric in the Method and select the new 
metric.
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Creating an EC-50 or IC-50 Curve

1 To determine the EC50 value for a given compound, pair a data file with a Method, 
then define the regions and gates.
If the compound-specific sample set is part of a larger data set, create a group to 
define this specific subset (see “Creating a Group” on page 4-46). Then drag the 
group to the legend sector replacing the original FCS data file. 

2 Click the Show Pie Legend icon in the tool bar to open the workspace. Click IC50 at 
the top of Workspace.
A graph appears where x and y axes are defined as Concentration (log10 scale) and 
response level % (linear), respectively.
The y coordinates correspond to the numerical values derived from the 
AnalysedGroup. Values are converted to a relative scale where the maximum derived 
value is set to 100% on the y axis.
The x coordinates represent the actual compound concentrations used at each step 
in the titration. The axis display is open and set automatically from the range of 
concentrations used. 

3 To set the x-axis values for the curve, click the Setup button.
The setup dialog appears, displaying the wells used in the analysis, the Sample ID, 
and Quantity. 

The Sample ID is derived from the original FCS file. If a sample ID was not entered for 
each well, the default well name appears (A01, A02). 

4 Enter the Quantity (concentration) for each well. Quantity defines the x-axis values for 
the graph. These are user-defined and must be entered for each curve. 

If, during acquisition, you enter a concentration as the sample ID, you can click the 
Use Sample ID button to enter the Quantity. Characters before the “space” in the ID 
are used for the quantity. For example, if your sample ID is “3 um staurosporine,” the 
3 is used for the quantity. You can also type the values into the Quantity fields. Enter 
the actual number (.01, .001, .0001) or use scientific notation (1e-2, 1e-3, 1e-4). 
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5 Click OK to display the graph.
The EC-50 (IC-50) value is marked by a bold + on the curve. 

You can make the following adjustments to the data:
• Change the target value (from 20–80). For example, instead of viewing a graph 

where 50% of the effect is observed, set the EC or IC value to 25 to see where 
25% of the effect is observed.

• The Conc field provides the numerical value for the EC-50 point, in this case 0.16.
• Select between EC-50 and IC-50.

Special Features

Creating a Group

A group is a user-defined set of samples from one or more FCS files (or data sets). 
Grouping allows you to extract and analyze a subset of samples from the data set(s). You 
can also use grouping to apply different Methods to subsets of data that are part of a 
single FCS file, to get different statistics, for example.
To create a group:

1 Select the FCS data file in the Data pane.
The plate map displays the samples acquired in that file. 

Toggles between EC-50 and IC-50

what is this field for?

Select between EC-50 and IC-50.
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2 Drag the cursor across the appropriate wells in the plate 
map, right-click the selected wells, and choose Create 
group from the menu. 
To select non-consecutive wells, press the Ctrl key while 
clicking to select wells. The order that you select and add 
the wells to the group is the order that they will be in the group. 
The group name appears under the original FCS file in the Data pane. To rename the 
group, double-click the name and type in the new name.
To add additional samples to an existing group, select the wells and drag them to the 
group in the Data pane.

 NOTE: You can combine samples from different FCS files; however, if you select the 
same/overlapping wells, the plate map and plots will display only the first of the 
overlapping well(s) selected (eg, the first A01 selected). 

3 To remove an individual well, right-click it and select Remove Item. The deleted well 
is removed from the group and appears as an empty square in the plate map. Wells 
can be deleted only from groups, not from the original FCS file. To delete a group, 
select it and click the Delete Group icon in the Data pane.

 NOTE: Use the Duplicate Group icon in the Data pane to make a copy of a group. 

You can also use the icons at the bottom of the Data pane to create, open, save, 
duplicate, and delete a group.

Group under the data file from which it was created.
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Data Pooling

During analysis you can combine the data from multiple samples into a single sample. 
This can be useful when analyzing rare events.
To pool samples, you must first pair a data file with a method to create an analyzed group.

1 Click a well that you wish to pool data from other wells into, then drag to select the 
other wells. 

2 Right-click the selected wells and choose Pool Samples from the menu. 

The data combined from all selected wells appears in the plots. The wells appear in 
the plate map with the label number of the first selected well. 

To see the new combined number of events for a given population, open the Current 
Run Stats window by selecting Tools > Show Current Run Stats. If stats have not 
been created, click the New Stat Marker icon to the right of the plot and select New 
Stat for Rx. Select Count as the Metric and click OK.

3 To “unpool” the data, click and drag to select the wells (in any order). Right-click the 
selected wells and choose Cancel Pooled Samples.

Example: 
D01 is selected and cursor is dragged through D03. 
Right-click and select Pool Samples. Wells D02 and 
D03 now appear with 01 label.

Combined (pooled) data for D01 through D03 
appears in the plots.
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Overlaying Histograms

The histogram overlay feature allows you to superimpose histograms from multiple 
samples derived from one data file. By selecting a different color for each sample, you 
can see the different sample data overlaid within the same plot. Each histogram plot has 
its own overlay list. 

1 Click the Edit Overlay List icon (last icon in the tool bar of the histogram plot).
The Overlay Setup dialog box appears with the currently displayed sample well listed 
as base in the far-left column and <current> under Sample ID. 

2 To add samples to the overlay list (and plot), drag a well directly from the plate map to 
either the histogram plot or the Overlay Setup dialog box. To select multiple wells, 
drag to select wells or use the Ctrl key to select non-consecutive wells.
The plot will display the selected sample data in 
the designated colors. When you overlay plots, 
any markers you had previously set, as well as the 
stats, apply to the base plot only. The overlays are 
derived from the same gate as the initial plot. You 
can also change the parameter displayed by 
clicking the x-axis label and choosing a different 
parameter. 
• To change the overlay order, click the number (or “base”) in the left column and 

drag it to a new location in the list. 
• To remove data for an individual sample, click to select the well in the list and click 

Delete.
• To hide the data for an overlay from the plot, click to remove the check mark from 

the Show check box.
• Click Line Style, Line Color, and Fill Color to change the appearance of the overlay.

 NOTE: You cannot overlay sample data with different plot parameters. A message will 
appear informing you that some samples do not have the required parameters. 
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Printing Results
Before printing results, use the Print Preview option to customize the information that 
prints.

1 If necessary, set up the page orientation, paper size, and margins by selecting File > 
Page Setup.

2 Select File > Print Preview.

The Print Preview window appears. 

3 Select how you wish the results to print:
• Select the plots to print by clicking the check box next to the plots. The selected 

plots will print in the order they are listed. If you wish to reorder the plots in the list, 
click and drag a plot to a new location in the list.

• Check to includes the statistics. The stats will appear in a table at the end of the 
printout. 

• Select how many samples you wish to print per page.
• Select how many rows you wish to print per sample.
• To scroll through the pages, place the cursor on the page, then click and drag (the 

hand) to move the page.
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guava InCyte™ Troubleshooting

Problem Possible Cause Solutions

InCyte™ will not launch; 
prompts you for an unlock 
code.

An unlock code was not 
entered or was entered 
incorrectly.

Contact EMD Millipore 
Technical Support for the 
unlock code. 

InCyte™ starts in Analysis 
mode. Acquisition mode is 
not available.

Communication problem 
between instrument and 
laptop. 

Ensure USB cable is 
connected between 
instrument and laptop. 

Gates and/or events in plots 
disappear.

1. Data file or Method is 
selected.

2. Data was acquired in tubes.
3. More than 96 samples were 

acquired.

Click on the AnalyzedGroup 
in the Analysed Data pane to 
display data and gates.

Few events, as indicated in 
Cell Count section of 
Sample Information control 
panel.

1. Clogged flow cell.

2. Insufficient sample volume.

3. Cells in suspension have 
settled.

1. Remove sample, load 
bleach, click Backflush. 
Follow with Quick Clean.

2. Minimum sample volume is 
90 µL.

3. Click Abort. Remove 
sample, mix, reload, and 
reacquire.

Unexpected events 
appearing in plots.

Instrument settings not 
optimal. Acquiring debris.

Adjust settings so debris is 
below threshold.

FSC Count under Cell 
Count shows events, but 
the events appear in the 
wrong places in plots.

1. Sample was not stained.

2. Cell lysis.

1. Check sample. If 
necessary, restain sample 
from original suspension.

2. Check buffers used to 
process cells.
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No events, as indicated in 
Particle Count section of 
Sample Information control 
panel.

1. Sample tube or plate not 
loaded.

2. No cells in sample.

3. Clogged flow cell.

4. Broken flow cell.

5. Sample pump not working.

6. Laser not operational.

7. Loose fitting on minstac 
tubing (under metal plate).

1. Ensure tube is loaded and 
loader assembly is up.

2. Ensure correct sample is 
loaded.

3. Remove sample, load 
bleach, click Backflush. 
Follow with Quick Clean 
using DI water.

4. Remove flow cell and 
inspect for damage. 
Replace if necessary. 

5. Run Quick Clean and 
watch for fluid in waste 
vial.

6. Allow laser to warm up for 
15 min. If laser is not on, 
contact EMD Millipore 
Technical Support.

7. Ensure tubing connector is 
secure.

Events appear in some 
plots but not in others.

Ensure correct gate is 
selected for plot in question.

1. Open plot menu, point to 
Apply Gates and select 
gate.

2. Check gate definition to 
ensure it includes the 
correct regions and 
operators.

Events appear off scale in 
dot plots or histograms.

Gains set incorrectly, or 
samples staining brightly. 

Adjust gain setting so 
positive populations appear 
on scale. Repeat Adjust 
Settings with negative 
sample. Adjust 
compensation settings.

Cannot resolve dim positive 
staining from background 
signal. 

Dirty capillary. Perform at least one cycle of 
Guava® Clean. 
While acquiring samples, 
select Clean & Rinse instead 
of Quick Clean, and if 
necessary, run it frequently.

Problem Possible Cause Solutions
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Poor resolution between 
positive and negative 
populations.

1. Gains too low to detect 
fluorescent signals.

2. Incomplete staining with 
fluorescent probe, or 
fluorescent probe 
inappropriate for cell type.

3. Fluorescent probes over-
exposed to light, stored 
improperly, or expired.

4. Non-specific binding of 
fluorescent probes.

5. Background noise too high. 

1. Adjust settings to increase 
fluorescent signal. Adjust 
compensation settings.

2. Ensure positive control is 
staining adequately and 
with correct reagent.

3. Refer to reagent package 
insert for proper storage 
instructions. Do not expose 
reagent to excessive light. 
Do not use expired 
reagents.

4. If using antibody-based 
probes, try Fc blocking 
reagent during staining to 
minimize non-specific 
binding. Otherwise, titer 
the fluorescent probes 
down to reduce the 
nonspecific staining.

5. Adjust settings to increase 
FSC threshold to remove 
debris. Or, wash stained 
sample and reacquire.

Poor resolution between 
positive populations.

1. Incomplete staining with 
reagent(s).

2. Too much reagent in 
staining tube. 

3. Fluorescence background 
too high.

4. Gain too high causing 
signal to bleed into other 
parameters.

5. Gain too low to optimally 
detect positive signal.

6. Background noise too high.

1. Check expiration date and 
amount of reagent(s) used 
in staining.

2. Washing cells may remove 
residual reagent.

3. Washing cells may remove 
residual reagent.

4. Adjust settings to reduce 
gain. Adjust compensation 
settings.

5. Adjust settings to increase 
gain. Adjust compensation 
settings.

6. Adjust settings to increase 
FSC threshold to remove 
debris. Or, select one of 
the fluorescence 
parameters as the 
threshold.

Problem Possible Cause Solutions
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Appendix A
Administrator Features

Setting up Access Control
guavaSoft™ software, version 3.1, supports features which allow a laboratory 
administrator in controlled environments to restrict users from access to certain features 
of the guava easyCyte™ System to help ensure that standard procedures are followed 
correctly. Users whose access has been restricted cannot change instrument or analysis 
settings, and may only operate the guava easyCyte™ System according to previously-
saved Settings files or the instrument default settings.

Who Should Read This Section on Administrator Features

By default, after installation there are no access control restrictions, and the default “GTI” 
user account has access to all features of the software. If such unrestricted access is 
sufficient for your needs, then no further steps are necessary and you may begin using 
the software.
You should read this section if:
• you want to use access control in your laboratory or environment, or
• you want to create new user accounts, or
• you are a network administrator and need information about the guava® system 

environment in order to create guava® user accounts in a manner consistent with your 
local security policy

We recommend that you contact your local network administrator for help in setting up 
user accounts and access control.
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Access Control Levels

guavaSoft™ software, version 3.1, supports three levels of access control, Administrator, 
Supervisor, and Operator. Each user account under the Windows® operating system has 
one of these levels, which is assigned by the lab administrator on a case-by-case basis. A 
higher access control level always has privileges of all access control levels below.
Administrator-level user accounts have unrestricted access to all features of the software 
including the “Administration Configuration,” and are assumed to be guavaSoft™ 
software Administrators who know how to properly configure all features of the software 
for supervisor-level and operator-level users.
Supervisor-level user accounts have unrestricted access to all features of the software 
except the “Administration Configuration” (see page B-13) and are assumed to be expert 
users who know how to properly use all features of the software at the supervisor and 
operator levels.
All user accounts can:

• perform the Adjust Settings step
• retrieve instrument settings files
• start new data sets
• run the easyCyte™ System and acquire data (entering all relevant information such as 

sample IDs, number of events to acquire, and dilution factor and original volume, when 
applicable)

• perform Quick Clean, Backflush, and Cleaning operations
• run the easyCheck™ Procedure
• abort an acquisition, when necessary
• export data to FCS 2.0, 3.0, or CSV format
• add comments to event log
• view event log file
Operator-level user accounts cannot:

• change instrument settings (FSC gain, PM1 or PM2 voltages, pump speed)
• adjust markers or gates
• make any adjustments during the Adjust Settings step
• use Next Step, except to (a) finish Adjust Settings, or (b) terminate a normal 

acquisition
• save instrument settings
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Before Setting Up Access Control

The guavaSoft™ software, version 3.1, installer automatically creates the three different 
guava® User Groups under Windows, namely, GuavaAdmin, GuavaSupervisor, and 
GuavaOperator. The correct access to the various guava® files needed to function 
properly are also automatically set up by the installer.

 IMPORTANT NOTE: If you plan to connect the system to a network, be sure to contact 
your local network administrator for help, since the procedures described here may 
need to be modified in order to comply with security policies in effect for your local 
network.

“First-Time Setup After Installation” describes steps which need to be taken only once, 
after installation of the software. It explains how to set up the guava® Settings Files folder 
access control.
“How to Create A New User Account” describes how to create a new user account. 
“Assigning a guava® Access Control Level to a User Account” describes how to assign 
the access control level (Administrator, Supervisor, or Operator) to a user account.

First-Time Setup After Installation
This section shows you after installation, the three User Groups, GuavaAdmin, 
GuavaSupervisor, and GuavaOperator are automatically created. The steps to set up the 
folder for the guava® Setting Files are also described in this section. 
The GuavaAdmin group is used by guavaSoft™ software to allow the guava® 
Administrator to configure the “Administration Configuration.” This option is available from 
the guavaSoft™ software main menu to a guava® Administrator only. The GuavaAdmin 
group consists of only those users who are to share responsibility for administering 
Access Control. All members of the GuavaAdmin group should also be a Windows 
Administrator. Only these users (or a Windows administrator) will be able to assign or 
change the access control levels for other users.

Three User Groups Automatically Created Upon Installation

1 Log on as administrator. (No password is required by default.)
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2 Right-click My Computer and select Manage from the menu. The Computer 
Management window appears. Expand the content of the “Local Users and Groups” 
folder and click on the “Groups” folder.

Create the guavaSoft™ “guavaSettings” Folder

1 Double-click My Computer. Double-click Shared Documents. Create a new folder in 
the Shared Documents folder called guavaSettings.

 NOTE: If using Windows® 7 OS, the Shared Documents folder does not exist under 
My Computer. Request that your IT department create a guavaSettings folder that is 
accessible to the appropriate users. 
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How to Create A New User Account

1 Log on as administrator.

2 Right-click My Computer and select Manage from the menu.

3 Find Local Users and Groups and click to expand its contents. Click the Users folder. 

4 Select New User from the Action menu in the menu bar at the top of the window. The 
New User dialog box appears.
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5 Enter a user name to be added to the system. Type in a full name (first and last), a 
password and confirmation, and a description. In the example below, a user account 
“User1” for “Joe Smith” in “R&D” is created.

6 Click Create. You may continue adding more users by repeating the steps starting 
with step 4. Click Close when you are finished adding users.

7 You will need to assign each user to the proper access control group. Proceed to 
“Assigning a guava® Access Control Level to a User Account” for this information.

Assigning a guava® Access Control Level to a User Account
This section shows you how to assign the Access Control level to a user account for 
guavaSoft™ software. You do this by assigning the user to one of the groups created in 
“First-Time Setup After Installation” on page A-3.
If you want the user to be able to administer Access Control for other users or to be able 
to configure the “Administration Configuration,” (normally, very few users should have this 
right), add the user to the GuavaAdmin group as shown below. Also make sure that the 
user you have added to the GuavaAdmin group is also a Windows Administrator.
In a similar manner, a user account can be assigned to have either Supervisor- or 
Operator-level access control simply by adding the user to either the GuavaSupervisor or 
GuavaOperator group, respectively, as shown below.
Be careful not to assign a user to more than one guava® group. The higher Group 
privilege takes precedence, which may not be what you want.

1 Log on as a Windows Administrator.

2 Right-click My Computer and select Manage from the menu.

3 Navigate to the Groups folder under “Local Users and Groups.”
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How to Give a User Account GuavaAdmin-Level Access

1 Right-click on the GuavaAdmin group and select Properties.

2 Click Add in the GuavaAdmin Properties window.
The Select Users window appears. 

3 Enter the user login name for the administrator and click OK.

4 Repeat these steps to add additional administrators.

 NOTE: If a user in the GuavaAdmin group is NOT a Windows Administrator, you can 
add the user to the Administrators group:
• Right-click My Computer and select Manage from the menu.
• Click the Groups folder under the “Local Users and Groups” folder.
• Right-click on the “Administrators” group in the right side of the window and select 

Add to Group from the menu. 
• Click Add in the Administrators Properties window.
• Select the user you want to add to the Administrators group and click Add.
• Click OK when you are finished.

How to Give a User Account GuavaSupervisor-Level Access

1 Right-click on the GuavaSupervisor group and select Properties.

2 Click Add in the GuavaSupervisor Properties window.
The Select Users window appears. 

3 Enter the user login name for the supervisor and click OK.

4 Repeat these steps to add additional supervisors.
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How to Give a User Account GuavaOperator-Level Access

1 Right-click on the GuavaOperator group and select Properties.

2 Click Add in the GuavaOperator Properties window.
The Select Users window appears. 

3 Enter the user login name for the operator and click OK.

4 Repeat these steps to add additional operators.

5 Reboot the system when finished. Click the Start button, click Turn Off Computer, 
click Restart.

Information For Network/IT Administrators
• User accounts which function as administrators for guava® Access Control do not 

need to have Windows Administrator privileges, they only need full control of the 
AccessRights folder within the guavaSoft™ folder hierarchy.

• The guavaSettings folder described in “First-Time Setup After Installation” does not 
need to be in C: drive. It can be located anywhere as long as all users can access it. 
Although the setup procedures above do not detail how to do this, the Operator-level 
accounts do not need access to the guavaSettings folder, since they cannot create 
Settings files. Therefore, you could obtain greater security by arranging that the 
GuavaOperator Group has only Read access to the guavaSettings folder.

• All guavaSoft™ software users need Read/Write/Modify access to the Log folder when 
running the easyCheck™ Procedure, since this assay updates the GuavaCheckLog.

Administration Configuration
Administrators can configure or customize certain software features for supervisors and/
or operators. 
You must be logged on as an administrator to gain access to the Setup button on the 
guavaSoft™ software main menu.
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1 Click Setup from the main menu. 

The Customize guavaSoft screen appears.

2 Select Configure under Access Rights. 

Available to administrators 
who log onto the system.
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3 Click the check boxes for the features you wish to allow for supervisors and/or 
operators. 

The following table describes each feature.

Feature Description

Disable Append to File If selected, will not allow user to append to an existing FCS 
3.0 file. Users may overwrite the existing file or create a 
new file. This applies to a data file when you click New 
Data Set (or Start New Data Session File for InCyte™) at 
the start of a session.
If overwriting is disabled (see below), you will be appending 
to a copy of the existing file since you cannot overwrite it. If 
overwriting is allowed, you will be appending to the end of 
the existing file.

Disable Overwrite File If selected, will not allow users to overwrite an existing FCS 
3.0 file. Users may append to the existing file or create a 
new file. This applies to a data file when you click New 
Data Set (or Start New Data Session File for InCyte™) at 
the start of a session, as well as to a data file when you 
make changes during analysis.

Require easyCheck Fields If selected, the user must enter values for the Bead Lot #, 
Bead Expiration Date, and Expected Particles/mL before 
starting every easyCheck™ run. If this option is not 
selected, the information will default to the last information 
entered.

Require non-blank ViaCount 
Fields

If selected, the user must enter values for the Reagent Lot 
# and Reagent Expiration Date before a ViaCount Assay 
can be started. If this option is not selected, the reagent 
information is not required.
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4 Click OK to save the settings.

Include Full User Name on 
Printouts

If selected, the user’s full name is included on all printouts 
generated by that user. This information is taken from the 
“Full Name” field in the user’s Windows XP account record.

Include “Reviewed By Field” 
on Printouts

If selected, places a Reviewed by: __________ field on all 
printouts generated by the user. 

Disable retrieval of InCyte 
Settings

If selected, users cannot adjust instrument settings or 
retrieve InCyte™ Methods, instrument settings, and 
compensation settings from individual Method or 
instrument settings files. Methods, instrument settings, and 
compensation settings can only be retrieved from a single 
FCS file.

Feature Description
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Appendix B
Glossary

acquisition The electronic and software function of collecting various 
types of information from a cell sample.

Analysed Group An FCS file created in InCyte™ software. It contains the 
sample data and the Analysis Method. When data is 
acquired in InCyte™, the software will automatically pair the 
data set and Method for analysis. If data were acquired in 
any other guavaSoft™ module, you will need to pair the data 
with a new or existing Method during analysis to form the 
Analysed Group. 

analysis The software function of numerically and graphically 
manipulating data to identify and separate cell populations for 
the purpose of calculating relevant statistical information. 

antibodies A class of proteins secreted by sensitized B lymphocytes 
following contact with an antigen. Also referred to as 
immunoglobulins. Monoclonal antibodies, derived from a 
unique secreting clone of the parent B cell, are characterized 
by their highly specific antigen binding capabilities.

area The area under the electronic pulse. The area measurement 
provides a more accurate assessment of total signal 
fluorescence.

caspases Cysteinyl-directed aspartate-specific proteases. A family of 
enzymes that initiate the apoptotic cascade, carry out cellular 
breakdown, and process cytokines.
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coefficient of 
variation (%CV)

The ratio of the standard deviation to the mean, expressed 
as a percent. It is calculated using the formula: 

compensation A process of reducing the unwanted fluorescence signal of 
one fluorochrome overlapping into the range of wavelengths 
of another fluorochrome.

data set A series of samples included within one file for a selected 
assay. An FCS file and a spreadsheet file are saved for each 
data set.

depolarized cells Cells in which the mitochondrial membrane potential has 
collapsed. Because of this loss of negative potential, the 
JC-1 dye no longer accumulates in the mitochondria, causing 
cells to fluoresce mostly green.

detector A device used to measure light intensity. The fluorescence 
detectors are photomultiplier tubes (PM1, PM2, and PM3) 
and the FSC detector is a photodiode. Both output a current 
that is proportional to the intensity of incident light.

dot plot A graphical representation of two-parameter data. Each axis 
of the plot displays values for one parameter. A dot 
represents the values for a cell or particle.

FBS Fetal bovine serum. A cell-free extraction of blood obtained 
from fetal calves used to supplement growth media in tissue 
culture.

FCS file Flow Cytometry Standard file. A data file containing the 
results for an individual sample as well as all acquisition 
information at the time of data collection. FCS files are 
defined by the Data Files Standards Committee of the 
Society for Analytical Cytology. Cytometry. 1990;11:323–332.

flow cell An optical assembly within the guava easyCyte™ System. 
The flow cell consists of a metal shuttle holding a glass 
capillary with a tiny chamber where the laser beam 
illuminates the sample stream and cellular measurements 
occur. 

%CV = SD
x

x 100
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fluorescence The phenomenon of light emission that occurs when a 
fluorochrome’s excited electrons drop to a lower energy level. 

fluorochrome A fluorescent dye used as a detection reagent in cell analysis 
applications. A molecule capable of absorbing light at a 
certain wavelength, then emitting light at a longer wavelength 
(fluorescence) as it releases energy. For a list of all 
fluorochromes compatible with the easyCyte™ System, see 
“Fluorochromes” on page 4 of the Specifications section.

FSC Forward scatter. Light scattered as a particle passes in front 
of the laser beam. Forward scattered light is used as an 
indicator of relative particle size and incorporates both the 
particle’s cross-sectional dimension and refractive index.

gate A graphical boundary that defines a subset of data. Gates 
may be set on a single-parameter histogram or a two-
parameter dot plot. 

helper/inducer T cells T cells that promote the immune response by releasing 
soluble helper factors such as interleukin 2 and interleukin 4.

histogram A graphical representation of single-parameter data. The 
horizontal axis of the graph represents the increasing signal 
intensity of the parameter and the vertical axis represents the 
number of events (cells).

isotype control An antibody of the same immunoglobulin class and 
fluorescent capacity as the test reagent, but having no 
specificity for the target antigen or other antigens present on 
the test cells. The isotype control is used to estimate 
nonspecific binding of the test reagent.

laser Light amplification by stimulated emission of radiation. A light 
source that is highly directional, monochromatic, coherent, 
and bright. The emitted light is in one or more narrow spectral 
bands, and is concentrated in an intense, narrow beam.

marker A boundary or set of boundaries used to segregate data into 
subsets for statistical analysis. Set a marker on a histogram 
to obtain statistics on a certain region. Set quadrant markers 
on a dot plot to obtain statistics on data within four quadrants.
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mean fluorescence The average of the fluorescence intensities of each event 
acquired within a given set of events.

median The axis value for the event that falls in the middle of the 
distribution.

Method The part of an InCyte™ FCS file that contains all the analysis 
components (gates, regions, markers, plots, parameters, and 
statistical setup). Methods can be part of the FCS file and can 
also be saved to a separate file (.gsy). Data files acquired 
using a program other than InCyte™ will not have Methods 
associated with them, therefore you must use a new or 
existing Method before you can analyze the file using 
InCyte™.

monocytes Immature macrophages found in the blood.

NK cells Natural killer cells. Non-T, non-B lymphocytes found in 
normal individuals and capable of killing some tumor cells 
and some virus-infected cells.

offset A baseline detector setting for an individual assay to ensure 
that the cells are being detected.

parameter A specific cell property that is measured as the cell passes in 
front of the laser beam. Each parameter is the output from a 
photomultiplier (which measures fluorescence) or a 
photodiode (which measures forward scatter).

PMNs Polymorphonuclear cells. Myeloid cells that are derived from 
the bone marrow. These cells possess a lobulated, irregular 
nucleus and cytoplasm that is filled with granulocytes. PMNs 
consist of neutrophils, eosinophils, and basophils.

PMT Photomultiplier tube. A device used for measuring light 
intensity.

polarized cells Cells which exhibit a normal mitochondrial membrane 
potential, and hence when exposed to the JC-1 dye, 
fluoresce mostly orange.
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population A group of cells that express similar values within one or 
more parameters. For example, cells that are positive for a 
particular antibody appear in the same location within a 
histogram or dot plot. 

SR-VAD-FMK Sulforhodamine-valyl-alanyl-aspartyl-fluoromethylketone. 
A cell-permeable, noncytotoxic caspase inhibitor that 
covalently binds to multiple caspases that have been 
activated during apoptosis.

SSC Side scatter. Light scattered as a particle passes in front of 
the laser beam. Side scattered light is measured at 
approximately 90° from the incident laser beam. Side 
scattered light is used as an indicator of a particle’s relative 
internal granularity.

suppressor/cytotoxic 
T cells

T cells that suppress the response of other cells to antigen, 
or kill other cells in an antigen-specific manner.

T cells Lymphocytes that have undergone a period of processing in 
the thymus and are responsible for mediating the cell-
mediated immune response.

threshold The minimum level of discrimination to electronically 
eliminate unwanted signal. A threshold setting allows you to 
specify events you wish to acquire based on signal intensity 
of the event. Anything below the threshold in not acquired. 

width The width of the electronic pulse. The width measurement 
helps you discriminate doublets from singlets.
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Appendix C
Ordering Information

For ordering information contact the nearest EMD Millipore office by calling 1 800 645-5476, 
or visiting us on our website at www.millipore.com/offices. 
EMD Millipore and its distribution network will provide guava® products to all sectors of 
life science research in certain countries outside North America and Europe. 

Instrument Components

Software 

Parts Catalog Number

guava easyCyte™ 12 System (software not included) 0500-5012

guava easyCyte™ 8 System (software not included) 0500-5008

guava easyCyte™ 6-2L System (software not included) 0500-5007

guava easyCyte™ 5 System (software not included) 0500-5005

laptop computer 0110-3670

sample tube holder, titer tubes 0100-0060

sample tube holder, 1.5-mL microcentrifuge tubes 0100-2180

cleaning solution vial assembly (small, metal tubing connector) 0110-3030

(large, plastic tubing connector) 0110-8125

waste vial assembly (small, metal tubing connector) 0110-3020

(large, plastic tubing connector) 0110-8120

flow cell assembly 0500-2270

flow cell tightening tool 6000-2410

flow cell removal tool (tweezer model) 6000-3020

syringe assembly cleaning tool 0110-0210

guava easyCyte™ System User Guide text 0110-8493

instrument shipping box 0110-2640

guava easyCyte™ System Software Modules Catalog Number

guava® ExpressPro Software Module (required for 6-color operation) 0500-4125

guava InCyte™ Software Module 0500-4120

guavaSuite Software Modules for the guava easyCyte 12 System 0500-4130
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Essential Tools 

Reagent Kits 

Kit Catalog Number
guava easyCheck™ Kit (50 tests) 4500-0025
Guava® ICF (Instrument Cleaning Fluid) [100 mL] 4200-0140

Cell Health Catalog Number
ViaCount Assay Kits
Guava® ViaCount Reagent (100 tests) 4000-0040
Guava® ViaCount Reagent (600 tests) 4000-0041
Guava® ViaCount Flex Reagent (100 tests) 4500-0110
Guava® ViaCount Flex Reagent (500 tests) 4700-0060
CDR (Cell Dispersal Reagent) [100 tests] 4700-0050
Cell Cycle Kits
FlowCellect® Bivariate Cell Cycle Kit for DNA Replication Analysis (25 tests) FCCH025102
FlowCellect® Bivariate Cell Cycle Kit for G2/M Analysis (25 tests) FCCH025103
Guava® Cell Cycle Reagent (100 tests) 4500-0220
DNA Damage Kits
FlowCellect® Multi-Color DNA Damage Response Kit (25 tests) FCCH025104
FlowCellect® DNA Damage Histone H2A.X Dual Detection Kit (25 tests) FCCS025153
FlowCellect® Cell Cycle Checkpoint H2A.X DNA Damage Kit (25 tests) FCCH025142
FlowCellect® Cell Cycle Checkpoint ATM DNA Damage Kit (25 tests) FCCH025143
FlowCellect® Histone H2A.X Phosphorylation Assay Kit FCCS100182
MitoHealth Kits
FlowCellect® MitoPotential Red Kit (100 tests) FCCH100105
FlowCellect® MitoDamage Kit (100 tests) FCCH100106
FlowCellect® MitoLive Kit (100 tests) FCCH100107
FlowCellect® MitoStress Kit (100 tests) FCCH100109
FlowCellect® Cytochrome c Kit (100 tests) FCCH100110
FlowCellect® Oxidative Stress Characterization Kit (25 tests) FCCH025111
guava® MitoPotential Kit (100 tests) 4500-0250
Apoptosis Kits
Early Apoptosis Kits
FlowCellect® Annexin Red Kit (100 tests) FCCH100108
guava® Nexin Reagent (100 tests) 4500-0450
guava® Nexin Reagent (500 tests) 4500-0455
Mid Apoptosis Kits
guava® MultiCaspase SR Kit (100 tests) 4500-0500
guava® Caspase 9 SR Kit (100 tests) 4500-0520
guava® MultiCaspase FAM Kit (100 tests) 4500-0530
guava® Caspase 3/7 FAM Kit (100 tests) 4500-0540
guava® Caspase 8 FAM Kit (100 tests) 4500-0550
guava® Caspase 9 FAM Kit (100 tests) 4500-0560
guava® MultiCaspase SR and Caspase 3/7 FAM Kit (100 tests) 4500-0570
guava® MultiCaspase SR and Caspase 8 FAM Kit (100 tests) 4500-0580
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guava® MultiCaspase SR and Caspase 9 FAM Kit (100 tests) 4500-0590
guava® Caspase 9 SR and Caspase 3/7 FAM Kit (100 tests) 4500-0630
guava® Caspase 9 SR and Caspase 8 FAM Kit (100 tests) 4500-0640
guava® Caspase 9 SR and MultiCaspase FAM Kit (100 tests) 4500-0650
Late Apoptosis Kits
guava® TUNEL Kit (100 tests) 4500-0121
Apoptosis Signaling Kits
FlowCellect® Bcl-2 Activation Dual Detection Kit (25 tests) FCCS025108
Autophagy
FlowCellect® GFP-LC3 Reporter Autophagy Assay Kit (CHO) [25 tests] FCCH100170
FlowCellect® Autophagy Reagent Pack (25 tests) FCCF200097
FlowCellect® GFP-LC3 Reporter Autophagy Assay Kit (U20S) [25 tests] FCCH100181
FlowCellect® RFP-LC3 Reporter Autophagy Assay Kit (25 tests) FCCH100183
FlowCellect® Autophagy LC3 Antibody-based Assay Kit (100 tests) FCCH100171

Immunology Catalog Number
Intracellular Cytokine Kits
Helper T Cell Kits – Mouse
FlowCellect® Mouse Th1 Intracellular Cytokine Kit (25 tests) FCIM025123
FlowCellect® Mouse Th2 Intracellular Cytokine Kit (25 tests) FCIM025124
FlowCellect® Mouse Th17 Intracellular Cytokine Kit (25 tests) FCIM025125
FlowCellect® Mouse Th1/Th2 Intracellular Cytokine Kit (25 tests) FCIM025137
FlowCellect® Mouse Th1/Th17 Intracellular Cytokine Kit (25 tests) FCIM025138
FlowCellect® Mouse Th1 Differentiation Tool Kit (25 tests) FCIM025161
FlowCellect® Mouse Th2 Differentiation Tool Kit (25 tests) FCIM025162
FlowCellect® Mouse Th17 Differentiation Tool Kit (25 tests) FCIM025163
FlowCellect® Mouse Treg Differentiation Tool Kit (25 tests) FCIM025166
T-Cell Kits – Human
FlowCellect® Human FOXP3 Treg Characterization Kit (25 tests) FCIM025118
FlowCellect® Human CD4/CD8 T Cell Kit (100 tests) FCIM100158
T-Cell Kits – Mouse
FlowCellect® Mouse FOXP3 Treg Identification Kit (25 tests) FCIM025126
FlowCellect® Mouse Viable Treg Characterization Kit (25 tests) FCIM025168
B-Cell Identification Kits – Human
FlowCellect® Human Memory B Cell Identification Kit (25 tests) FCIM025159
FlowCellect® Human B Cell FAS Kit (100 tests) FCCH100137
B-Cell Identification Kits – Mouse
FlowCellect® Mouse Breg Identification Kit (25 tests) FCIM025154
Immune Cell Health - Human
FlowCellect® Human T Cell Apoptosis Kit (100 tests) FCCH100138
FlowCellect® T Cell MitoDamage Kit (100 tests) FCCH100139
FlowCellect® T Cell Activation Kit (100 tests) FCCH100141
FlowCellect® Human CD8 T Cell FAS Kit (100 tests) FCCH100140
FlowCellect® Human CD4 T Cell FAS Kit (100 tests) FCCH100154
FlowCellect® Human T Cell Caspase 3/7 Kit (100 tests) FCCH100157

Cell Health Catalog Number
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FlowCellect® Human T Cell Caspase 8 Kit (100 tests) FCCH100155
FlowCellect® Human T Cell Caspase 9 Kit (100 tests) FCCH100156
guava® CellToxicity Kit (100 tests) 4500-0230
guava® CellGrowth Kit (200 tests) 4500-0270

Cell Signalling Catalog Number
MAPK Pathway
FlowCellect® PI3K/MAPK Dual Pathway Activation and Cancer Marker Detection Kit (25 tests) FCCS025100
FlowCellect® EGFR/MAPK Pathway Activation Detection Kit (25 tests) FCCS025101
FlowCellect® MAPK Activation Dual Detection Kit (25 tests) FCCS025106
FlowCellect® p38 Stress Pathway Activation Detection Kit (25 tests) FCCS025132
EGFR Pathway
FlowCellect® EGFR/MAPK Pathway Activation Detection Kit (25 tests) FCCS025101
FlowCellect® EGFR/RTK Activation Dual Detection Kit (25 tests) FCCS025107
PI3/Akt/m-TOR Pathway

FlowCellect® PI3K/MAPK Dual Pathway Activation and Cancer Marker Detection Kit (25 tests) FCCS025100

FlowCellect® PI3K Activation Dual Detection Kit (25 tests) FCCS025105
FlowCellect® PI3K-mTOR Signaling Cascade Kit (25 tests) FCCS025210
Jak/STAT Pathway
FlowCellect® EGFR/STAT3 Pathway Activation Detection Kit (25 tests) FCCS025111
FlowCellect® Multi-STAT Activation Profiling Kit (25 tests) FCCS025550
FlowCellect® STAT1 Activation Dual Detection Kit (25 tests) FCCS025142
FlowCellect® STAT3 Activation Dual Detection Kit (25 tests) FCCS025143
Multiple Pathway
FlowCellect® PLC-gamma 1 Activation Dual Detection Kit (25 tests) FCCS025145
FlowCellect® Src Activation Dual Detection Kit (25 tests) FCCS025154
Apoptosis Signaling Pathway 
FlowCellect® Bcl-2 Activation Dual Detection Kit (25 tests) FCCS025108
Chemokine Receptor Kits
FlowCellect® Chemokine Receptor CCR1 Surface Expression Identification and Quantification 

Kit (25 tests)
FCCR100410

FlowCellect® Chemokine Receptor CXCR6 Surface Expression Identification and Quantification 
Kit (25 tests)

FCXR600424

Stem Cell Kits
Human
FlowCellect® Human NK Cell Characterization Kit (25 tests) FCIM025164
Rodent
FlowCellect® Rodent NSC Characterization Kit (Neural) [25 tests] FCRNC25112

Immunology Catalog Number
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Service Plans 
Service Total Plans Catalog Number

guava easyCyte™ 5 Service Total 1-yr plan (at time of purchase) 0500-5300

guava easyCyte™ 5 Service Total 1-yr plan (after purchase) 0500-5305

guava easyCyte™ 5 Service Total 2-yr plan 0500-5310

guava easyCyte™ 6-2L Service Total 1-yr plan (at time of purchase) 0500-5330

guava easyCyte™ 6-2L Service Total 1-yr plan (after purchase) 0500-5335

guava easyCyte™ 6-2L Service Total 2-yr plan 0500-5340

guava easyCyte™ 8 Service Total 1-yr plan (at time of purchase) 0500-5870

guava easyCyte™ 8 Service Total 1-yr plan (after purchase) 0500-5875

guava easyCyte™ 8 Service Total 2-yr plan 0500-5880

guava easyCyte™ 12 Service Total 1-yr plan (at time of purchase) 0500-6870

guava easyCyte™ 12 Service Total 1-yr plan (after purchase) 0500-6875

guava easyCyte™ 12 Service Total 2-yr plan 0500-6880

Preventative Maintenance Plans Catalog Number

guava easyCyte™ 5 Preventative Maintenance 1-yr plan (at time of purchase) 0500-5285

guava easyCyte™ 5 Preventative Maintenance 1-yr plan (after purchase) 0500-5290

guava easyCyte™ 5 Preventative Maintenance 2-yr Plan 0500-5295

guava easyCyte™ 6-2L Preventative Maintenance 1-yr plan (at time of purchase) 0500-5315

guava easyCyte™ 6-2L Preventative Maintenance 1-yr plan (after purchase) 0500-5320

guava easyCyte™ 6-2L Preventative Maintenance 2-yr Plan 0500-5325

guava easyCyte™ 8 Preventative Maintenance 1-yr plan (at time of purchase) 0500-5270

guava easyCyte™ 8 Preventative Maintenance 1-yr plan (after purchase) 0500-5275

guava easyCyte™ 8 Preventative Maintenance 2-yr Plan 0500-5280

guava easyCyte™ 12 Preventative Maintenance 1-yr plan (at time of purchase) 0500-6370

guava easyCyte™ 12 Preventative Maintenance 1-yr plan (after purchase) 0500-6375

guava easyCyte™ 12 Preventative Maintenance 2-yr Plan 0500-6380

On-Site Instrument Training and Application Support Part Number

guava easyCyte™ Installation and Basic Training (half day) 0500-1690

guava easyCyte™ Installation and Advanced Training (full day) 0500-1680

Installation Qualification/Operation Qualification (IQ/OQ) Part Number

guava easyCyte™ IQ/OQ (customer performed) 8000-1995

guava easyCyte™ IQ/OQ (EMD Millipore performed) 8000-1996 
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Additional Supplies

The following materials can be ordered directly from the manufacturer. 

Tubes Catalog Number

Microcentrifuge tubes, 1.5-mL, conical bottom, screw cap
• VWR International–clear tubes
• VWR International–screw caps
• VWR International–tubes with caps
• Fisher Scientific–clear tubes

16466-030
89004-346
60872-324

02-681-339

Microtiter tubes, 1.2-mL conical bottom, no caps
• E & K Scientific–tubes
• VWR International–tubes

604508-RC
46300-494
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Specifications

guava easyCyte™ System 

Operating Environment
temperature:
humidity:
power:
fuse rating:

Instrument size:
height:
width: 
depth: 

Instrument weight:
laptop size:

height:
width:
depth:

laptop weight:

16°–30°C (60°–86°F)
10–90% relative humidity (non-condensing)
100–240 VAC, 50/60 Hz, 120W
USA and Japan (110 V): 2.5 A, 250 V Time-lag
Europe: (220-240 V): 1.6 A, 250 V Time-lag (x2)

9.1 in (23.1 cm)
17.7 in (45 cm)
17.5 in (44.4 cm)
35 lb (15.9 kg)

11.5 in (29.2 cm) when open
14.2 in (36.1 cm)
10.4 in (26.4 cm)
8 lb (3.6 kg)

Optics
lasers:

forward scatter detector:
side scatter detector:
fluorescence detectors:

violet laser (405 nm), 100 mW
blue laser (488 nm), 150 mW
red laser (642 nm), 100 mW
photodiode
photodiode
See “easyCyte Lasers and Fluorescent Filters” on the 

following page.
Signal Processing

parameter dynamic range:

pulse processing:
time:

3.5 decades (except as noted below):
4.0 decades (guava® ExpressPro, and Caspase software 

module)
5.0 decades (guava InCyte™ software module)
digital signal processing
every particle time stamped
Specifications 1



Performance
counting accuracy:
counting precision:

±10%
≤10% CV

Fluidics
flow cell dimension:
pump:
sample flow rate:

cleaning and waste vials:
waste generation:
dead volume:
sample concentration:

sample requirement:

standard square capillary with ID of 100 µm
positive displacement 
7 µL/min to 36 µL/min (7 µL/min to 72 µL/min for guava 

InCyte™, ExpressPro, and Caspase modules)
15-mL glass vials with screw tops
typically <40 mL in 8 hours of continuous use
50 µL (for 1.5-mL tubes)
final particle concentration of 104 to 106 particles/mL for 

accurate results
as few as 2,000 cells/test; typically 25,000–100,000 cells/

test depending on the assay
Data Management

computer:

data file structure:

Dell™ laptop running Windows 7 Ultimate (32-bit only), and 
including Microsoft Excel. Minimum configuration: Intel 
Core i5-3210M processor (2.5 GHz, 3M cache); 4 GB, 
DDDR3-1600 MHz SDRAM; 320 GB hard drive; 2 USB 
ports 

Output data file formats:
• binary data storage in Flow Cytometry Standard (FCS) 

3.0 format
• spreadsheet results file in comma-separated value 

(CSV) format
• optional export of binary data in FCS 2.0 or 3.0 format
• optional CSV list-mode data
2 guava easyCyte™ System User Guide



easyCyte Lasers and Fluorescent Filters 

The following table lists the laser and power for each of the easyCyte™ instruments, and 
the filters used for each parameter. 

Filter
Instrument Legacy 

name
New 

Name5 & 5HT 6-2L & 6-2LHT 8 & 8HT 12 & 12HT

Laser 488 nm (blue) 488 nm (blue) 488 nm (blue) 488 nm (blue)

Power 50 mW 50 mW 150 mW 150 mW

FSC N/A X X X X FSC FSC

SSC 488/16 X X X X SSC SSC

Green-B 525/30 X X X X GRN GRN-B

Yellow-B 583/26 X X X X YLW YEL-B

Red-B 695/50 X X X X RED RED-B

NIR-B 785/70 N/A N/A X X NIR NIR-B

Laser

N/A N/A N/A

405 nm (violet)

Power 100 mW

Blue-V 450/45 X

N/A

BLU-V

Green-V 525/30 X GRN-V

Yellow-V 583/26 X YEL-V

Red-V 695/50 X RED-V

Laser

N/A

642 nm (Red) 642 nm (Red) 642 nm (Red)

Power 100 mW 100 mW 100 mW

Red-R 662/15 X X X RED2 RED-R

NIR-R 785/70 N/A X X NIR2 NIR-R
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Fluorochromes 

The following tables, list all fluorochromes that can be used with the easyCyte™ System, 
the laser that excites the dye, and the parameter/detector that detects the emitted signal. 

lue (448/50 nm) Green (525/30 nm) Yellow (583/26 nm) Red (661/15 nm) Red (695/50 nm) NIR (785/70 nm)

API AlexaFluor™ 430 Pacific Orange Alexa Fluor® 647 eFluor 650 PE-Alexa Fluor® 750

oescht 33258 Pacific Green Brilliant Violet APC Brilliant Violet Propidium Iodide

lexa Fluor® 405 Brilliant Violet™ Odot 565 CD647 Odot 705 PE-Cy™7

arnia Blue Odot 525 Odot 585 Cy™5 7-AAD APC-Cy™7

acific Blue™ Odot 545 Alexa 555 Odot 655 Propidium Iodide APC-Alexa Fluor® 750

ive/Dead Violet FITC Alexa 568 DRAQ5 PE-Alexa Fluor® 647

yLight 405 GFP CF™555 Ethidium bromide PE-Alexa Fluor® 700

Fluor 450 AlexaFluor™ 488 CD568 Ethidium homodimer PE-Cy™5

ombie Aqua™ CF™488 PE-B, PE-R SYTOX® Red PE-Cy™5.5

rilliant Violet™ Cy™2 PE-Texas Red® TO-PRO™-3 PE-Texas Red®

FAM Odot 565 TOTO-3 PerCP

Rhodamine 110 Acridine Orange DilC1(5) PerCP-Cy™5.5

Odot 525 dsRED MitoSense Red Odot 705

Acridine Orange Ethidium bromide BODIPY™ 650/665 DRAQ5

EGFP Ethidium homodimer Ethidium bromide

EYFP SYBR Gold Ethidium homodimer

Thiazole Orange SYBR Green LDS-751

SYBR Gold SYTOX® Orange Nile Red

SYBR Green TO-PRO™-1

SYTO® BC JC-1

SYTOX® Green TMRE

YO-PRO™-1 TRMR

YO-YO™-1 CFSE

DiOC6(3) Nile Red

JC-1

Rhodamine 123

BODIPY™-FL

Calcien

CFSE

Oregon Green™ 405-nm laser 488-nm laser 642-nm laser
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Compliance

The guava easyCyte™ System contains three lasers:
• a Class IIIb laser operating at 405 nm in CW mode
• a Class IIIb laser operating at 488 nm in CW mode
• a Class IIIb laser operating at 642 nm in CW mode
Light shields within the instrument enclose the path of laser radiation. Additionally, the 
instrument enclosure provides secondary protection from any laser radiation. 
This product complies with:
• CFR (Code of Federal Regulations) Chapter 1, Subchapter J and installation 

(overvoltage) category II
• Class 1 limits for exposure to laser radiation set by the Center for Devices and 

Radiologic Health (CDRH)
• EN 60825-1:2007, EN 61010-1:2010, and EN 61326-1:2013
• CAN/CSA-C22.2 No. 61010-1-04, UL Std. No 61010-1 (2nd Edition)

Symbols

Attention, consult accompanying documents.

Affixed in accordance with European Council Directive 73/23/EEC

Danger, laser radiation

In accordance with Canadian Standards Association

Separate collection of waste at end of life as required by European Directives. 
Dispose of in accordance with the applicable country regulation.

Dangerous voltage

Power on

Power off

C US
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Notice to Purchaser: Limited Use License

Use of this product is covered by one or more of the following US patents and 
corresponding patent claims outside the US: (5,798,222; 6,403,378; 6,710,871; 
6,816,257; 7,320,775; 7,410,809; 8,184,271 and 7,847,923). The purchase of this 
product includes a limited, non-transferable immunity from suit under the foregoing patent 
claims for using this product by the purchaser for its own internal research. No right under 
any other patent claim, no right to perform any patented method, and no right to perform 
commercial services of any kind, including, without limitation, reporting the results of 
purchaser's activities with use of the product for a fee or other commercial consideration, 
is conveyed by express implication, or by estoppel. This product is intended for research 
use only. Diagnostic uses require a separate use license from EMD Millipore. Further 
information on commercial licenses may be obtained by contacting the Director of 
Licensing, as listed on EMD Millipore's website:
http://www.emdmillipore.com/proprietary-technologies-available-for-licensing/
c_bhCsHfETIxYAAAE1gKU2Vc2d?back=true
The Product has not been tested by EMD Millipore for safety and efficacy in food, drug, 
device, cosmetic, commercial or any other use.
The Product is not a medical device for the purposes of the Medical Devices Regulations 
2002 or any other Regulations derived from Directive 98/79/EC (“Medical Devices”), and 
the Product is not in any circumstances to be sold or distributed for use as a Medical 
Device.
EMD MILLIPORE AND ITS AFFILIATES shall not, no matter how such liability may be 
purported to arise, except in the case of personal injury or death arising directly out of the 
gross negligence, recklessness or willful misconduct of EMD MILLIPORE OR ITS 
AFFILIATES, be liable to the Purchaser, or purchaser's affiliates or purchaser's 
customers, employees or students, for any loss or damage (including consequential 
damage or economic loss or loss of profits) arising out of, or in connection with, the sale 
or use of the Product.
TO THE FULLEST EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL 
EMD MILLIPORE'S LIABILITY ARISING OUT OF THE MANUFACTURE, SALE, 
SUPPLY, USE OR DISPOSITION OF THE PRODUCT, WHETHER BASED ON 
WARRANTY, CONTRACT, TORT OR OTHERWISE, EXCEED THE ACTUAL PRICE 
PAID BY PURCHASER FOR THE PURCHASED PRODUCT.
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Warranty
EMD Millipore Corporation (“Millipore”) warrants its products will meet their applicable 
published specifications when used in accordance with their applicable instructions for a 
period of one year from shipment of the products. MILLIPORE MAKES NO OTHER 
WARRANTY, EXPRESSED OR IMPLIED. THERE IS NO WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. The warranty 
provided herein and the data, specifications, and descriptions of Millipore products 
appearing in Millipore's published catalogues and product literature may not be altered 
except by express written agreement signed by an officer of Millipore. Representations, oral 
or written, which are inconsistent with this warranty or such publications are not authorized, 
and if given, should not be relied upon.
In the event of a breach of the foregoing warranty, Millipore’s sole obligation shall be to 
repair or replace, at its option, the applicable product or part thereof, provided the customer 
notifies Millipore promptly of any such breach. If after exercising reasonable efforts, 
Millipore is unable to repair or replace the product or part, then Millipore shall refund to the 
Company all monies paid for such applicable Product. MILLIPORE SHALL NOT BE 
LIABLE FOR CONSEQUENTIAL, INCIDENTAL, SPECIAL, OR ANY OTHER DAMAGES 
RESULTING FROM ECONOMIC LOSS OR PROPERTY DAMAGE SUSTAINED BY ANY 
COMPANY CUSTOMER FROM THE USE OF ITS PRODUCTS.

© 2014 EMD Millipore Corporation. All rights reserved. No part of these works may be 
reproduced in any form without permission in writing.
Unless otherwise stated in our catalog or other company documentation accompanying the 
product(s), our products are intended for research use only and are not to be used for any 
other purpose, which includes but is not limited to, unauthorized commercial uses, in vitro 
diagnostic uses, ex vivo or in vivo therapeutic uses, or any type of consumption or 
application to humans or animals.
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Index
A
Abort button 1-16
Acquire Next Sample button 1-15
Acquisition screen 1-14 to 1-17
adjusting settings

InCyte assay 4-8 to 4-11
analysis

InCyte 4-13 to 4-32
Analysis screen 1-18 to 1-19
area, pulse measurement

InCyte 4-9
assays

Guava InCyte 4-6 to 4-19
Autostart Acquisition feature 1-16

B
Backflush button 1-16
backflushing fluid system 1-7, 3-4
backgating 4-24
beads, easyCheck 2-3
bleach solution

adding to waste vial 3-6
for backflushing 3-4
for cleaning 3-3
for Quick Clean 3-1

buttons
Abort 1-16
Acquire Next Sample 1-15
acquisition 1-15
assay 1-9
Backflush 1-16
Cleaning 1-9
easyCheck 1-9
Exit 1-10
Next Step 1-15
Quick Clean 1-16
Save and Close Current Sample 1-15
Setup 1-9
Start Worklist 1-15
stop and close session 1-16
Stop Worklist 1-15

C
cleaning

flow cell 3-6 to 3-9
Guava Clean 3-2 to 3-3

outside of instrument 3-1
Quick Clean 3-1
solution 3-1, 3-3

cleaning solution vial 1-7
filling 3-4

clog 1-7, 3-4
compensation

during adjust settings 4-10
post acquisition 4-35
semi-automated 4-36

computer, internal
connecting to network 1-3

contour plots
InCyte 4-3

counting
beads, easyCheck 2-4
gate, InCyte 1-17, 4-11

D
data analysis

InCyte 4-13 to 4-32
deionized water

for Quick Clean 3-1
system shutdown 2-2, 3-3

dilution factor
Guava InCyte 1-17

E
easyCheck 2-3 to 2-4

beads 2-3
event log 2-6
exporting results 2-6
logging comments 2-6
reviewing previous results 2-5
trend graph 2-6, 2-7
troubleshooting 2-8

events to acquire
InCyte assay 1-17

exporting
easyCheck results to spreadsheet file 2-6
event log 1-22
InCyte results to spreadsheet file 4-33

F
FCS 2.0 data file 4-33
FCS 3.0 data file 1-20
Index  9



file name
data set 4-7
instrument settings 1-20

files
appending 1-21
FCS 2.0 4-33
FCS 3.0 1-20
overwriting 1-21
settings 1-20, 1-22

flash drive 1-7
flow cell

backflushing 3-4
cleaning 3-6 to 3-9
replacing 3-10 to 3-11

flow cytometry standard (FCS) file
exporting 4-33

fluid system 1-7
fuses, replacing 3-12

G
gate

InCyte 4-22 to 4-25
Guava Clean 3-2 to 3-3
Guava EasyCyte 1-1, 1-6 to 1-7

cleaning 3-2 to 3-3
cleaning solution vial 3-4
flow cell 3-6, 3-10
fluid system 1-7
laser 1-7
loading samples 1-6
power conditioner 1-2
waste vial 1-7, 3-5

Guava ICF 3-1, 3-3
Guava InCyte

acquisition control panel 1-17
analysis methods 4-14
assay 4-6 to 4-19
changing parameter names 4-5
compensation 4-10
contour plots 4-3
creating groups 4-46
EC50 4-44
exporting results to spreadsheet file 4-33
gating 4-22 to 4-25
HeatMap 4-38
overlaying histograms 4-49
post-acquisition compensation 4-35
printing current run stats 4-28
printing group stats 4-32
pulse area 4-9
pulse width 4-9
regions 4-19 to 4-22
setting statistical thresholds 4-43

statistics 4-26 to 4-32
troubleshooting 4-51
unlocking 1-10
workspace 4-5

guavaSoft software 1-1
Acquisition screen 1-14 to 1-17
Analysis screen 1-18 to 1-19
main menu 1-8
overview 1-8 to 1-11
quitting 2-2
starting 2-1

H
HeatMap 4-38

I
InCyte assay 4-6 to 4-19
installing the system 1-2 to 1-3
instrument settings

adjusting 1-15
files 1-22
retrieving 1-15, 1-23
saving 1-16, 1-23
See also adjusting settings

L
laser 1-7
loading a sample 1-6
loading samples 4-8

M
minstac tubing 3-6

N
Next Step button 1-15

O
order information K-1 to K-5
original volume

Guava InCyte 1-17
overlaying histograms 4-49

P
power conditioner 1-2
printer 1-3
printing

easyCheck results 2-6
printing results

InCyte 4-28, 4-32

Q
quadrant markers
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InCyte 4-27, 4-27
Quick Clean 3-1
Quick Clean button 1-16
quitting, guavaSoft 2-2

R
replacing

flow cell 3-10 to 3-11
fuses 3-12

retrieving instrument settings 1-23
running

easyCheck 2-3 to 2-4
Guava Clean 3-2 to 3-3
Quick Clean 3-1

S
sample ID

InCyte assay 1-17
when using Autostart Acquisition 1-16

sample loader
changing tube holders 1-3
loading a sample 1-6

sample number
for appended files 1-21
InCyte assay 1-17

Save and Close Current Sample button 1-15
saving instrument settings 1-23
settings files 1-20, 1-22
shutting down system 2-2
Start Worklist button 1-15
starting

guavaSoft software 2-1
system 2-1

Stop Worklist button 1-15
system

components 1-2
shutdown 2-2
startup 2-1

T
threshold setting

InCyte assay 4-10
troubleshooting

easyCheck 2-8
InCyte 4-51

tubes supported 1-3
tubing

minstac 3-6

U
unlocking InCyte 1-10

W
waste vial 1-7

emptying 3-5
width, pulse measurement 4-9
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For ordering information or technical support, 
call toll-free in the USA and Canada,
Phone: +1 (800) 645-5476
Fax: +1 (951) 676-9209

For additional contact information, visit www.millipore.com

25801 Industrial Blvd.
Hayward, CA 94545-2991 USA

0110-8493 Rev B
12/14

© 2014 EMD Millipore Corporation
All rights reserved.
Printed in the U.S.A.
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